
D3.4b - Initial Implementation of an authoring platform for adaptive VR learning material   (v1.0), 
2010-01-25 

Initial Implementation of a VR authoring tool Page 1 (76) 

 

 
 

 

GRAPPLE 
D3.4b Version: 1.0 

Initial Implementation of an authoring platform for  adaptive VR learning 
material  

 

Document Type Deliverable 

Editor(s): Frederic Kleinermann (VUB) and Olga De Troyer (VUB) 

Author(s): Frederic Kleinermann (VUB) and Olga De Troyer (VUB) 

Reviewer(s): Noaa Barak (ATOS) and Dominik Heckmann (DFKI) 

Work Package:  WP3 

Due Date:  M18 

Version:   1.0 

Version Date:  2010-01-25 

Total number of pages: 76 

 

Abstract:  This document is the second deliverable of Work Package 3, task T3.4. It describes the initial 
implementation of the authoring tool for Virtual Reality learning material. While deliverable 3.4a provides 
related work and gives a general overview of the design for the VR Authoring tool, this deliverable provides a 
more in depth on how the VR authoring tool has been implemented. It also provides a revised version of 
deliverable 3.4a and a short user guide. 

 

Keyword list:   Virtual Reality, authoring tool, adaptation, domain model, CAM model 

 

 

 



D3.4b - Initial Implementation of an authoring platform for adaptive VR learning material   (v1.0), 
2010-01-25 

Initial Implementation of a VR authoring tool Page 2 (76) 

Summary 

WP3 focuses on the design and development of a GRAPPLE authoring tool to support authors in writing 
adaptive courses. Task 3.4 is about developing an authoring tool which allows authors to specify how VR 
material can adapt. The authoring and delivery of adaptive VR Learning material are the focus of 
Deliverables D3.4a, D3.4b, D3.4c, D4.2a, D4.2b and D4.2c. 

This deliverable will describe the implementation of the VR authoring tool which is part of the general 
Grapple Authoring Tool (GAT). It follows the deliverable D3.4a and focuses mainly on the implementation of 
the authoring platform for adaptive VR learning material.  

The purpose of this deliverable is: 

·  To update and revise the material from the previous deliverable (D3.4a); 

·  To describe the implementation of the VR authoring tool component; 

·  To explain how it is integrated with the rest of the Grapple Authoring Tool (GAT); 

·  To provide a short user-guide. 

 

If you are familiar with D3.4a, you can quickly read through chapter 1-3. Chapter 4 onwards is new to this 
deliverable. 
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1 Introduction 

This document gives an overview of the Virtual Reality (VR) Authoring tool for GRAPPLE. This report is 
structured as follows: 

·  Chapter 1 gives a general introduction. 

·  Chapter 2 gives some related work. 

·  Chapter 3 provides a general overview of adaptation for VR. 

·  Chapter 4 provides an update to the design given in D3.4a. 

·  Chapter 5 gives a description of the implementation of the VR Authoring tool and its integration with 

the other Grapple Authoring Tools (GAT). 

·  Chapter 6 gives an overview of the tool. 

·  Chapter 7 presents a User Guide. 

·  Chapter 8 provides a general discussion. 

·  Chapter 9 provides the conclusion. 

In this chapter we will briefly start by reminding the reader what VR is. Then, we will explain why adaptation 
for VR and what is the difference between VR and Simulation. 

1.1 Virtual Environments  

There are many definitions of Virtual Environments (VE) or Virtual Reality (VR) (Gutierrez et al., 2008). 
Usually, the restrictive approaches define VR as three-dimensional (3D), multisensorial, immersive, real time, 
and interactive simulations of a space that can be experienced by users via three-dimensional input and 
output devices. For the context of this research, VR is defined as a three dimensional computer 
representation of a space in which users can move their viewpoints freely in real time. 
 

A VR application is made of different components and can be summarized as: 
 

(1) The scene and the objects 
 
The scene corresponds to the world in which the objects are located. It contains lights, viewpoints 
and cameras. Furthermore, it has also some properties that apply to all the objects being located 
inside the virtual world. For instance, gravity can be a property of the world that applies to all its 
objects. The objects have a visual representation with colour and material properties. They have a 
size, a position and an orientation.  
 
(2) Behaviours 
 
The objects may have behaviours. For instance, they can move, rotate, change size and so on. 
 
(3) Interaction 
 
The user must be able to interact with the virtual world and its objects. For instance, a user can 
pick up some objects or he can drag an object. This may be achieved by means of a regular mouse 
and keyboard or through special hardware such as a 3D mouse or data gloves (Gutierrez et al., 
2008). 
 
(4) Communication  
 
Nowadays, more and more VR applications are also collaborative environments in which remote 
users can interact with each other. To achieve this, network communications is important.  
 
(5) Sound 
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VR applications also involve sound. Some research has been done over the last ten years in order 
to simulate sound in VR application. 

 

 

Figure 1. Virtual Environment 

Figure 1 shows an example of Virtual environment. In this virtual environment, the user is represented by an 
avatar (here on the figure 1, a warrior) which is an object with behaviour. The platforms, on which the avatar 
can stand on, are objects without behaviours. The user interacts through either the keyboards or the mouse.   

1.2 Why Adaptation in Virtual Reality? 

Virtual reality brings 3D content that can help the user to learn or acquire a better understanding of a topic or 
a context. In the context of E-Learning, VR can helps learner to understand better the different concepts of 
course by being immersed in a 3D virtual world. The adaptation in VR can help the learner to focus only on 
VR objects that relevant to him and not to see the whole virtual world. As Virtual World can be rich and 
explored in different ways, it can also give the sensation to the user to be lost. This should be avoided and 
especially in the context of E-learning. Therefore, it is important to have a virtual world that can adapt to the 
user. This can be a way to avoid having the user being lost inside a Virtual World.  

To achieve this, it is important to define what can be adapted inside a VE, how it can be adapted and what is 
the process that takes a VE and changes it in real-time according to the learner’s background and 
knowledge. 

1.3 Virtual Reality and Simulations 

It can be said that VR and simulations are very closely related concepts. A VR can be seen as a space in 
which the user is immersed and in which he can see a simulation. However in the context of VR for E-
learning, the user is not learning about how to make a virtual world, he is using VR as a place where the 
learning takes place. While in the context of Simulations for E-learning, the learner is learning either about or 
how to control and use the model being simulated.  

1.4 Challenges related to adaptation for VEs 

As it can be seen in VE, content is composed of 3D objects placed in 3D space. In VEs, users move 
seamless and it is different from following links like in web by clicking on it. As a consequence, it is difficult to 
apply well known techniques used in adaptation for hypertext. For instance, if an object is inserted in space 
(like we do in the same way when inserting paragraphs in a page), there will be risk to have a cluttered, 
incomprehensible and not navigable VE ! Therefore, 3D content requires special care to preserve a 
meaningful and understandable 3D space. Objects should normally not intersect each other and must be 
visible from various user positions, while users must have enough free space to move around in. Therefore, 
it is a real challenge to provide adaptations and we are forced to do it in a specified way and also in a limited 
way in order to have adaptation strategies specific for VE.   
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2 Related work 

This chapter will start by reviewing some work using 3D or VR for E-learning. We provide this section to 
illustrate that VR and 3D is indeed feasible in the context of E-learning. The second part of the chapter will 
describe related work that is also dealing with adaptation in a 3D learning environment. 

2.1 E-learning in 3D environments 

In this subsection, a number of 3D environments developed for E-learning will be reviewed. The purpose of 
this section is to show the possibilities of 3D environments in the context of E-learning and to illustrate that in 
the future more and more 3D learning material may become available. Some work is based on existing 
Virtual Reality (VR) platforms (more specifically VR for the web) and others on Game platforms. More and 
more, game platforms are used for purposes other than pure entertainment (see e.g., the Serious Games 
initiative1). 

Barab et al. (2005) have used a commercial gaming environment to develop a multiuser, virtual learning 
environment to immerse children, ages 9-12, in educational tasks. It allows users at participating elementary 
schools and after-school centres to travel through virtual spaces to perform educational activities, talk with 
other users and mentors, and build virtual personae. 3D aspects are provided through the game platform 
and customization is provided, but here there is no real adaptation in the sense of adapting the objects 
populating the virtual world at real-time according to the student’s background and knowledge.  

Livingstone and Kemp (2008) introduce a learning environment approach integrated with SecondLife2 (an 
online 3D virtual world) and Moodle3 (a course management system). Their approach is called Sloodle. It 
mimics the structure of a Moodle course homepage with 3D objects (see figure 2). When the course designer 
repositions web content blocks, the corresponding objects are automatically repositioned. Sloodle does not 
provide any adaptation to the user’s profile. But it is interesting to see the use of SecondLife as learning 
environment as well as the use of virtual objects specific for E-learning. They have also developed gestures 
of avatars (see figure 3) specific for E-learning. 

 

Figure 2. Sloodle 

                                                      
1 http://www.seriousgames.org 
2 http://secondlife.com/ 
3 http://moodle.org/ 
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Figure 3. Gestures of Avatars in Sloodle 

Alexiou et al. (2004) have presented a virtual laboratory, which is designed and implemented in the 
framework of the VirRAD European project. This laboratory represents a 3D simulation of a radio-pharmacy 
laboratory, where learners, represented by 3D avatars, can experiment on radio-pharmacy equipment by 
carrying out specific learning scenarios. The work also does not produce adaptations at real-time according 
to the student’s background and knowledge. 

Moreno-Ger et al. (2008a) describe a design and implementation methodology for medical simulations that 
avoids the high development costs of VR-like simulations (see figure 4). Their methodology takes into 
account that educational games and game-like simulations cannot be independent artifacts and therefore 
must be integrated with co-existing courses and training modules. For their work, they use <e-Adventure> 
(see further on) which is an educational game engine and which also has different plug-ins with the objective 
of integrating the educational games with online learning environments compliant to IMS Learning Design 
specification.   

 

Figure 4. <e-adventure> used for medical simulation 

Recently, Torrente et al. (2009) discuss how games can be mixed with an E-learning. They explain the 
challenges associated to that and how they are addressing them with the e-adventure platform. They 
describe their authoring tool and how they try to make the life easier for the author. The work reported in this 
paper is different from the one reported in this deliverable as they do not take into account how to allow an 
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author to define adaptation inside virtual environments. Nevertheless, this paper is interesting for us as they 
try to make the life easier for the author. 

De Byl (2009) presents an Embedded Authentic Serious game-based Learning Experiences (EASLE) 
architecture which has been developed to assist in the definition of game based applications. De Byl makes 
the remark that contemporary game design architectures place a great emphasis on storylines and character 
development in a top-down approach. For him, this is not adequate and for this reason, EASLE allows 
designer to specify game aspects by building up a foundation layers where each successive layer refines the 
previous one and makes a Gameplay more complete. The layers are Story, Scenes, Icons, Theme, Game 
rules, Gameplay mechanics and Genre. This work does not allow adaptations based on the user’s 
background and knowledge, but it does provide a methodology to develop game-based learning 
environments.  

The Alive X3D project4 is to bring the power of 3D gaming and simulation technologies to e-learning 
platforms and to educational experiences. It is based on the observation that most of the 3D environments 
for teaching focuses mainly on the distribution of existing learning materials coupling with tools for 
communication. The Alive X3D project adopts Web 2.0 in a move towards interoperable and reusable 3D 
learning objects, forming a Web2.0 – Web3D hybrid approach (see figure 5). Their work does not take into 
account any adaptation, but it shows how virtual environment can be used in the context of E-learning on the 
Web. 

 

Figure 5. AliveX3D 

KM Quest5 is a Web-based simulation game aiming at developing core knowledge management skills with 
situated problems using collaborative learning. It is a team-based game in which 3 players are responsible 
for a fictitious company called Coltec. In that game, players are given an introduction to the basic concepts of 
knowledge management and training on game. The training consists of a limited form of the game with 
restricted choices and fixed events during the guidance, coaching and immediate feedback is given. 3D 
aspects are provided through the game platform. Also here, there is no real adaptation in the sense of 
adapting the objects populating the virtual world at real-time according to the student’s background and 
knowledge. 

                                                      
4 http://www.alivex3d.org 
5 http://www.kmquest.net 
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Virtual U6 is a project started in 1997 aiming at creating a computer simulation of university management in 
game form. It is based on the idea of creating a “SimCity” for universities. It has been now used across 
universities on America and demonstrates the use of games for E-learning (see figure 6). 

 

 

 

Figure 6. Virtual U 

Like KM Quest, 3D is provided through the game platform, but there is no true adaptation. 

2.2 Adaptation and 3D Environments 

The previous section did show that there exist different efforts in merging E-learning with 3D Virtual 
Environments. In this section, we will review related work in the context of adaptation and 3D virtual 
environments. Recall that the purpose of adaptation in E-learning is to personalize the course material to the 
profile of the learner. This section has a large overlap with the section “State of the Art and Related Work” in 
the deliverable D4.2b, which deals with the adaptive delivery of VR. This is because in most work on 
adaptation for 3D environments, there isn’t a strict distinction between the authoring and delivery. So, that 
kind of work is relevant for both deliverables. To indicate the overlap between the two deliverables, the 
sections that are exactly the same are indicated by means of a vertical line in the left margin in both 
documents. 

Brusilovsky et al. (2002) have developed an approach that supports different navigation techniques in the 
context of 3D E-Commerce. Their approach is based on Adaptive Hypermedia methods, which they have 
extended to Virtual Environments (here a 3D shop). They have introduced:  
 

Direct Guidance. This technique is based on the principle used in adaptive hypermedia where the 
user receives the best ‘next’ link according to his background. They have extended this principle to 
VR where the link is replaced by a viewpoint in the virtual world and where the best viewpoint 
according to his background, is given to the user. 
 
Hiding. This technique is based on the principle used in adaptive hypermedia where the navigation 
is restricted to a set of links. To realize this, they create different viewpoints for a specific object. 
These viewpoints are inside a scene sphere and as a result, the user cannot view any object out of 
this sphere. They have defined a new technique called Gaze Fixation where users can walk past 
the object with a system-generated orientation. It allows users to still control their position but not 
their orientation. 
 
Sorting. This technique is based on the principle used in adaptive hypermedia where the links are 
sorted according to the user’s goal. A standard adaptive hypermedia application creates links 
related to a specific topic and arranges them according to their relevance. They have extended this 
principle to 3D environments by introducing Point of Interest navigation that adjusts the viewer’s 
motion speed logarithmically in relation to the distance from an object of interest. 
 

                                                      
6 http://www.virtual-u.org/ 
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Annotation.  In adaptive hypermedia, a link can be displayed differently according to the user’s 
interest. For instance, the colour of a link can be changed or its visualization can be changed. They 
have extended this principle to 3D environments in two ways: either by drawing an arrow pointing 
to the possible interesting object (see left side of figure 7) or by using the flashlight technique that 
highlights the object of interest (see right side of figure 7). 
 

 

Figure 7. Adaptive navigation technique 

Santos and Osorio (2004) have introduced another approach for adaptation in Virtual Environments.  Their 
approach is called AdapTIVE (Adaptive Three-dimensional Intelligent and Virtual Environment) and is based 
on agents, called Interactive and Virtual Agents (IVAs) that assist the users and help them to interact with the 
environment. These agents help the user to discover the environment by providing him more information 
about interesting products, and by guiding him to his preferred area or products. Figure 8 displays the 
architecture of the proposed approach. They have applied their approach to E-commerce and Distance 
Learning systems. 
 
 

 

Figure 8. Santos and Osorio Software architecture Figure 8. Santos and Osorio Software architecture 
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Daschelt et al. (2002) have developed an approach that provides adaptation to the user’s device. Their 
approach suggests different alternatives with respect to the screen space usage for the same 3D interface 
element and information presented. Furthermore, 3D content is also considered in media adaptation. For 
instance, they describe a showcase where the seat capacity of a conference room can be adapted (see 
figure 9). The work presented in this paper is more on adapting the content for large audience, but not on 
personalization. 
 

 

Figure 9. Virtual Conference 

Moreno-Ger et al. (2008b) have developed an approach called <e-Adventure> which is an educational game 
engine designed to facilitate the creation of interactive educational content. It supports an adaptive model. 
The <e-Adventure> platform also includes a visual editor that facilitates the creation of the documents that 
describe the games (see figure 10). The platform can be integrated with a virtual Learning Environment 
(Moreno-Ger et al., 2008d). In their approach (Moreno-Ger et al., 2008c), the engine queries the Learning 
Management System for a set of properties (like for instance, the grade of a student) that are used to adapt 
the game. The games are defined so that different values of those properties will change the initial state of 
the gamer and as a consequence the game will be adapted. In this work, the content is adapted at the 
beginning of the game based on the student’s profile. The work presented is very interesting in the context of 
GRAPPLE as it does provide an authoring tool allowing authors to create courses and it does provide some 
adaptations. However, the adaptations are only done between sessions or during an evaluation. 
Furthermore, the content is mostly 2D, no true 3D.  

In Blanco al (2009), they discuss the potential of combining learning environments with games and the 
challenges related to that. They present a general architecture that aims to tackle these challenges by 
abstracting the communication between the game and the learning environment. To achieve this, they have 
developed a Game Adaptation Layer (GAL) that monitors the student-game interaction through an API that 
the game core must implement. The GAL uses the interaction data collected to maintain a record of the 
activity of the student. Their work is similar to our work as we also do have some kind of abstraction 
represented in our architecture by Update Component and the Monitor Component. The Update Component 
can communicate to different Web VR players that can be interacted through JavaScript. The Monitor 
Component is responsible to monitor in real-time the students and to report that to GALE. Based on this, 
GALE can then instruct how to adapt the virtual world. But the difference with our work is that we have a VR 
authoring tool which allows an author to specify what should be adapted inside the virtual world, how and 
when (see deliverable 3.4b (Kleinermann and De Troyer, 2009) ). Furthermore, they do not make a direct 
link with an adaptation engine such as AHA! or GALE. 

In Westra et al (2009), they a model for game adaptation that is guided by three main concerns: the trainee, 
the game objectives and the agents. More specifically, their approach uses the concept of learning agents to 
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introduce adaptations. In order to coordinate the adaption of the agents, they use an organizational 
framework that specifies the limitations of the adaptation in each context. The work is interesting in the sense 
that they provide an approach to make adaptation for complex serious games. However, they do not really 
provide any kind of authoring tool that can allow author to decide what should be adapted and when. 

 

Figure 10. <e-adventure> Authoring tool 

 

Celentano and Pittarello (2004) have developed another approach for adaptive navigation and interaction 
where a user’s behaviour is monitored in order to exploit the acquired knowledge for anticipating user’s 
needs in forthcoming interactions. The approach uses sensors that tell when an object has been interacted 
with. These sensors collect usage data and compare them with previous patterns of interaction. These 
patterns represent sequences of activities that users perform in some specific situation during interactive 
execution of tasks and are encoded in Finite State Machines. Whenever the system detects that the user is 
entering a recurrent pattern of interaction, it may perform some activities of that pattern on behalf of the user. 
Their approach focuses more on the navigation and interaction.  

In 2000, Chittaro and Ranon (Chittaro and Ranon, 2000) has described how to introduce adaptation inside e-
commerce. Their approach is called ADVIRT. A set of personalization rules exploits a model of the customer 
to adapt features of the VR store, such as the display of products through the concept of shelf, display spots 
and banners. They have also customized and personalized the navigation and different layouts of the store. 
The work reported in this paper focuses on E-commerce.  

In 2002, Chittaro and Ranon (Chittaro and Ranon, 2002) have introduced a software architecture for 
adaptive 3D web sites called Awe3D (Adaptive Web 3D) which can generate and deliver adaptive VRML. 
Awe3D has three modules namely a Usage Data Sensing module, a usage Data Recorder module, an 
adaptive engine and 3D content creator. The Usage Data Sensing module is to monitor user’s interaction 
with 3D Virtual Environment and sends the relevant events through the Internet. The Usage Data Recorder 
module is responsible for receiving the events sent by the Usage Data Sensing module and for recording 
them in the user model. The adaptive engine is responsible to perform inferences needed to update the user 
model and given the current user model to compute a set of adaptation choices for requested adaptive 
content. The 3D content creator accepts content request from the client. 

In 2007, the same authors has explained in a paper entitled “Adaptive 3D Web site” (Chittaro and Ranon, 
2007b) that adaptation can happen for navigation and interaction in order to help the users in finding and 
using information more efficiently. For navigation and interaction, they proposed direct guidance, hiding, 
sorting and annotation based on the work of Brusilovsky et al. (2002). Furthermore, they suggested an 
alternative approach for sorting and annotation by using virtual characters that act as navigation guides to 
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show users the path to an object or to a list of objects of interest, and to provide annotations in the form of 
additional information on navigation and interaction possibilities. An example of a humanoid character is 
shown in figure 11. 

Based on their previous work (Chittaro and Ranon, 2004), Chittaro and Ranon have extended the E-learning 
platform EVE (Chittaro and Ranon, 2007a). They introduced Adaptive EVE that is tailored to the knowledge 
level of a student and to their preferred style of learning. In that approach, they try to re-create the feeling of 
learning like in real-life. The student has to perform exercises and learn new materials adapted to students’ 
background. To achieve adaptivity in the context of EVE (Chittaro and Ranon, 2008), they have used the 
AHA! engine which was originally developed for adaptive hypermedia applications. Figure 12 provides an 
overview of their architecture. They have associated every concept in the domain model with related code in 
the Virtual Environment. When a student queries a specific concept by clicking on the object, the system will 
display the corresponding VE code depending on the current user’s level of knowledge. So the AHA! engine 
will use the user model and adaptation model to choose which 3D contents should be presented to student. 
To demonstrate their work, they have developed a course on X3D where the 3D content adapts to the 
student’s background. 

 

 
Figure 11. Humanoid character 
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Figure 12.E-learning adaptive environment 

 

 

This work is certainly close to the work to be developed for GRAPPLE. This work is not generalized enough 
so that any author can use an authoring tool for creating courses having 3D adaptive virtual environment. It 
certainly provides us with a lot of information on what to adapt and how to perform the adaptation. More 
information on X3D is given in (Brutzman and Daly, 2008). 

 

2.3 Discussion 

This section has presented work related to the use of Virtual Reality and 3D material in the context of E-
Learning. This section also presented some work done in the context of adaptation for Virtual Reality. Not all 
of the work on adaptation of Virtual Reality is oriented towards E-learning. Nevertheless, it provides us a 
good basis for defining different types of adaptation that could be used in the context of Virtual Reality for E-
learning. Most of the work on adaptation for Virtual Reality was done for one case (or one specific 
application) and is not general in the sense that it will easily be usable for other types of applications. As far 
as it concerns authoring tools for VR adaptation, only one related work was found. The <e-adventure> 
platform includes a visual editor that allows authors creating a course and provides some means for 
adaptation. However, it does not provide ways to allow an author to define what can be adapted, how and 
when.   
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3 Adaptation for VR in the context of GRAPPLE 

Based on the related work chapter, this chapter will consider possible adaptations for Virtual Reality (VR) in 
the context of GRAPPLE, to adapt VR learning material (3D objects as well as complete Virtual 
Environments) to the learner’s profile. This chapter will first review Adaptation Types for VR and then it will 
review Adaptation Strategies for VR. 

3.1 Adaptation Types for VR 

A VE can be adapted in many different ways. As described in the previous section, a VE contains a number 
of different components. In principle, adaptation can happen for each of these components. For GRAPPLE, 
we will first focus on adaptation for the objects, the behaviours and the interaction. We will now describe 
possible adaptations for the objects, the scene, behaviours and interaction. We call these possible 
adaptations Adaptation Types (AT).  

3.1.1 Adaptation Types for Objects  
Objects populating the VE have a visual appearance in terms of a geometry (shape) and material 
properties (colours and textures). To adapt a VE to the needs of the learner, it may be necessary to 
change the visual appearance of an object during the lifetime of the VE. We illustrate this with some 
examples. To visually indicate that an object has not yet been studied we may want to give it a different 
colour or make it smaller; when a learner is studying a complex object (like a planet), the visual 
appearance of the object could change according to the aspects being studied (size, temperature, 
geography, …) or become more detailed while more and more knowledge is acquired.  

Therefore, the first category of adaptation types for objects is concerned with the adaptation of the 
visualization of an object i.e. how to display it, and how to hide it. To adapt the display, we have 
identified four adaptation types: 

�  Semi-display: this adaptation type is used to display the object in a semi-manner, e.g., by having a 
semi-transparent bounding box around it. In other words, semi-display consists of adding a box 
around the actual object and by making that box semi-transparent.  

�  changeSize:  this adaptation type is used to change the visual appearance of an object by 
changing its size. 

�  changeMaterialProperties: this adaptation type is used to change the material properties (colour or 
texture) of an object.  

�  changeVRRepresentation: this adaptation type is used to change the visual representation of an 
object completely by replacing it by a different representation.  

Two adaptation types are concerned with hiding an object:  

�  semi-hide: this adaptation type allows the visual appearance of objects to be semi-hidden. This is 
similar as the semi-display but now the purpose is to hide the object in a semi-manner. 

�  hide: this adaptation type allows hiding an object visually. 

Furthermore, like in classical textual learning material, it is necessary to be able to mark objects. A 
reason for marking an object is for instance to draw the attention of the learner that the object has (or 
has not yet) been studied. In VR, marking an object can be done in different ways.  We distinguish two 
different adaptation types for marking because they are essentially different in terms of VR:  

�  spotlight: by putting a spotlight on an object the object becomes more visible than other objects and 
can be considered as marked.  

�  highlight:  here the marking is done by drawing a box around the object where only the edges of 
the box are displayed. 
 

Note that marking is considered different from changing the material properties (like the colour) of an 
object. By marking an object we don’t change any property of the object.  

In a VR learning environment, it may be useful to attach annotations to the VR objects. Annotation can 
be used to attach explanations. It may be necessary to adapt the annotations to the profile of the learner. 
Therefore, the following adaptation types are identified: 
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�  displayAnnotation: this adaptation type allows displaying an annotation associated with an 
object. 

�  hideAnnotation: this adaptation type allows hiding an annotation associated with an object. 

3.1.2 Adaptation types for the scene 
As explained in the previous section, the scene can have properties. We distinguish between physical 
properties, lighting, sound, and the material properties of the scene itself. It may be useful to be able to 
adapt these properties as well. For example, lighting can be used to visualize that some parts of the VE 
have already been visited or are not yet accessible.  

However, we will not yet elaborate further on possible adaptation types for the scene. If the available 
resources permit it, this type of adaptation will be considered in a later stage. 

3.1.3 Adaptation of Behaviours 
Behaviours are used to make the VE dynamic, i.e. to create environments where objects are active and 
show some behaviours like planets which are rotating and comets which move through the universe.  
Also for behaviour, it may be useful to consider adaptation. Possible adaptation types for behaviours are:   

�  enableBehaviour: this adaptation type allows enabling a behaviour associated with an object. 
�  disableBehaviour: this adaptation type allows disabling a behaviour associated with an object. 
�  changeBehaviour: this adaptation type allows changing a behaviour by modifying the values of its 

parameters. 

3.1.4 Adaptation of Interaction 
By interaction we mean interaction between the end-user and an object. There are different ways to 
interact with an object, e.g., by clicking on an object, by touching an object, by passing closed by an 
object, or by manipulating (for instance rotating) an object. Furthermore, interaction can trigger some 
behaviour. For example, by interacting with an object the end-user can move it or start an animation. To 
fully adapt the VE to the needs of the learner, it may be necessary to adapt the interaction. For example, 
as long as the learner has not obtained a certain level of background knowledge he should not be able to 
manipulate a certain object. Adapting interaction comes down to enabling or disabling the possible types 
of interaction provided for an object. Possible interaction types considered for objects are: touching, 
clicking, passing by, and manipulation. The adaptation types for interaction are: 

�  enable: this adaptation type allows enabling an interaction type for an object. 
�  disable: this adaptation type allows disabling an interaction type for an object. 

3.2 Adaptation Strategies for VR 

In this subsection, a number of VR Adaptation Strategies (AS) particularly useful in the context of e-learning 
will be discussed. Such an adaptation strategy goes beyond the adaptation of a single object. They can have 
an impact on several aspects of the VE or on a larger part of the VE.  In principle, adaptation strategies can 
be defined by means of the adaptation types defined earlier. We also have included adaptations strategies 
that are more like conditional adaptations, for instance the ‘displayAtMost’ strategy will hide an object after it 
has been displayed a given number of times. In general, a course author will use these VR adaptation 
strategies (in the author tool) to define how to adapt the VE rather then the individual adaptation types.  

A first group of strategies are those that will have an impact on how the learner can navigate through the VE. 
We have distinguished the following adaptation strategies for navigation: 

�  restrictedNavigation  
This adaptation strategy allows an author to restrict the navigation in the VE by allowing it to happen 
only among a given list of objects. In other words, the learner will only be able to navigate from an 
object to another object in the given list of objects. Furthermore, the navigation can be restricted to 
either jumping or walking.  

Jumping means going from one object to the next without viewing the part of the scene between the 
objects.  

Walking means following a path in the scene from one object to the next.  
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The list of objects that can be visited can be specified in different ways, e.g., based on the user 
knowledge or based on the objects that are pre-requisite of each other.  

Possible Scenario: This strategy can be used by the author of a course to force the learner to visit 
and explore only a pre-defined number of objects in a pre-defined way.   

�  navigationWithRestrictedBehaviour 
This adaptation strategy allows the author of a course to restrict the possible behaviours of objects 
while the learner is navigating. The restricted behaviour can apply on all objects or on a specified list. 
Also here, the list of objects can be specified in different ways, e.g., based on the user knowledge.  

Possible Scenario: This strategy can be used to first allow the learner to explore the VE but without 
having the objects showing any behaviour; afterwards when he is familiar with the environment 
behaviour can be enabled.  

�  navigationWithRestrictedInteraction  
This adaptation strategy allows an author of a course to define that navigation through a list of 
objects is possible but without being able to fully interact with them. Again, the list of objects can be 
defined in different ways. It is also possible to have this restricted interaction for all objects in the VE. 

Possible Scenario: This strategy can be used to first allow the learner to explore the VE but without 
allowing him to interact with the objects; afterwards when he is familiar with the environment 
interaction can be enabled.  

�  TourGuide 
The tour guide strategy can be used by the author to provide a tour guide to the learner to explain 
the context of the course. The tour guide will take the learner through a tour in a VE. 

Possible Scenario: Like in real life, a tour guide can provide an easy and efficient way to learn about 
objects in a large and unknown VE. 

 

The following adaptation strategies allow the author of a course to specify that the learner can navigate 
freely in the VE. We distinguish two types of free navigation strategies, namely completelyFree and 
freewithSuggestions.  

�  completelyFree  

This adaptation strategy will allow the learner to navigate freely in the VE. 

Possible Scenario: This strategy can be used in an exploration-based learning style to let the learner 
explore the VE without any constraints in terms of navigation. 

�  freeWithSuggestion 

This adaptation strategy will allow the learner to navigate freely in the VE but in addition, some 
objects will be “suggested”. This is done by marking them (using the adaptation type for marking an 
object, i.e. spotlight or highlight). Also here, the list of suggested objects can be specified in different 
ways.  

Possible Scenario: This strategy can be used to give the learner a lot of freedom but still provide 
some guidance.  

 

A second group of adaptation strategies are those that allow adapting a group of objects: 

�  filterObjects  
This adaptation strategy allows the author of a course to filter the objects that should be available 
(visible) in the VE. The filter is possible according to a certain criteria applicable on objects such as 
user-knowledge or user-background. 

Possible Scenario:  The author can use this strategy to only show to the learner the objects that he is 
allowed to learn according to the pre-requisite rules.  

�  markObjects  
This adaptation strategy allows the author of a course to mark (e.g., highlight) a number of objects in 
the VE. The marking will be done for all objects satisfying a certain criteria such as user-knowledge 
or user-background. 
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Possible Scenario: This strategy can be used during the course to draw the attention of the learner 
to the objects still to visit. 

 

A next group of adaptation strategies are strategies for displaying an object: 

�  displayAtMost  
This adaptation strategy allows an author to specify when an object should not be displayed 
anymore. This can be given by means of criteria like user-knowledge or by how many times it is 
allowed to display the object. 

Possible Scenario: The author can state that once the object has been displayed 10 times, it should 
not be displayed anymore. This will help learners to focus on the objects still to deal with.  

�  displayAfter 
This adaptation strategy allows an author to specify when an object should be displayed. This can be 
given by means of a criterion like user-knowledge or by means of a time criterion. 

Possible Scenario:  The author can use this strategy for instance to keep the scene dynamic and 
interesting by displaying some objects only after a random time.  

 

A next group of adaptation strategies are strategies for adapting the behaviour of an object.  

�  behaviourAfter 
This adaptation strategy allows an author to indicate when the behaviour of an object should be 
executed. This can be given by means of a criterion like user-knowledge or by means of a time 
criterion.  

Possible Scenario:  The author can use this strategy to state that the behaviour for a specific object 
should start only when the knowledge of the learner is above a certain threshold.  

�  behaviourAtMost 
This adaptation strategy allows the author to specify when a behaviour should be disabled. This can 
be given by means of a criterion like user-knowledge or by how many times it is allowed to execute 
the behaviour. 

Possible Scenario: The author can use this strategy to specify that if a behaviour of a specific object 
has been executed 10 times, then the learner must know it and it can be stopped to avoid that the 
learner will “playing” with it.  

�  behaviourSpeed  
This adaptation strategy allows the authors to specify the speed of a behaviour associated with an 
object. 

Possible Scenario: The author can use this strategy to make a behaviour e.g., a simulation of a real-
world behaviour, slower depending on the learner’s knowledge to allow him to observe the behaviour 
more carefully.  

 

The last group of adaptation strategies contains strategies for the interaction with an object. 

�  InteractionAfter 
This adaptation strategy allows the author to specify when the user can interact with the object. This 
can be given by means of a criterion like user-knowledge or by means of a time criterion.  

Possible Scenario: The author can use this strategy to ensure that the end-user has enough 
knowledge about the object before he can interact with it. 

 

 

�  InteractionAtMost 
This adaptation strategy allows the author to specify when the user cannot interact with the object 
anymore. This can be given by means of a criterion like user-knowledge or by how many times it is 
allowed to interact with the object.  
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Possible Scenario:  The author can use this strategy to limit the interaction with an object. Again, it 
may be important in some situations to force the learner to explore new objects rather than sticking 
too long to some well known objects.  

Figure 13 provides an overview of the adaptation types and adaptation strategies identified for VR.  

 

Figure 13. Overview of Adaptation types and strategies 
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4 Revisions  

The previous chapters are based revised version of chapters described deliverable 3.4a (Kleinermann and 
De Troyer, 2009a). However a number of changes have been made and this chapter will summarize them. 

There are three major changes. Firstly, we have introduced the notion of Virtual Reality Adaptation State 
(VRAS) in our design. This needed to be done as a number of problems still exist with current available VR 
players for the web. Secondly, Virtual Reality Conceptual Adaptation Model (VRCAM) can now be specified 
visually through a graph. This has been done in order to be consistent with how the CAM is made in the 
general authoring tool. Thirdly, the GAL code is now directly introduced inside the Virtual Reality Concept 
Relationships Types (VRCRT) when they are designed.   

4.1 Different Scenarios 

In deliverable 3.4a (Kleinermann and De Troyer, 2008a), it was explained a number of scenarios on how VR 
resources can be included inside CAM and having adaptation also inside VR.  

The first scenario was to be able to include VR resource inside a normal CAM. In that scenario, no 
adaptation happens inside the VR resource. This scenario is still valid and it will be shown in the next 
chapters how it is done.  

The second scenario was to be able to create adaptations that happen only inside VR resources. This 
scenario is valid and will be shown in the next chapters. To achieve this we have introduced the notion of 
VRCAM which is similar to CAM but dedicated to VR and VRCRTs which is also similar to CRTs, but they 
are dedicated to VR. Furthermore, we have introduced the notion Virtual Reality Adaptation State (VRAS) 
which will be explained in the next section and also in the next chapters.  

The third scenario was to combine the first scenario and the second scenario i.e. having adaptation inside 
VR and be able to include these VR resources having adaptation inside a normal CAM. This third scenario is 
still valid and it will be shown in the next chapters how it is done. 

 

4.2 Virtual Reality Adaptation State (VRAS) 

Deliverable 3.4a explained the design of the VR Authoring tool. Since then, we have introduced the concept 
of Virtual Reality Adaptation State (VRAS). A VRAS describes how a VR object will be changed after an 
adaptation. It helps the author to define how a VR object will be changed visually due to an adaptive action. 
For example, an author wants to light up a VR Object in some situation. To model this, the author can define 
an adaptation state (VRAS) where a spotlight is set on the VR object so that it lights up. He then can specify 
when the object must be in this VRAS using Virtual Reality Concept Relationships Types (VRCRT). 

Furthermore, a VRAS follows actually the description of chapter 3 in which it was described what can be 
adapted inside a virtual world made up of virtual objects with behaviours. It is for this reason that we support 
different kinds of VRASs such as spotlight, semi-hidden, marking, behaviour, and so on. It will be described 
in the next chapters how the VR authoring tool allows an experienced author to add a new VRAS.  

In terms of implementation, VRAS gives the advantage of being able to treat virtual objects as external 
resources similar to images (or videos) with the difference that they are dedicated only to VR. More details 
will be given in the next chapters. 

4.3 Visual Graph for VRCAM 

The goal was to have the VR Authoring tool integrated as much as possible with the other components of the 
Grapple Adaptive Tool (GAT) (Albert et al., 2009) (Hendrix et al., 2009) (Hendrix and Harrigan, 2009), not 
only from the implementation point of view, but also from the way authors will use the tool. Since the design 
of a CAM is done visually using a graph (see deliverable 3.3b (Hendrix and Harrigan, 2009), we also 
extended our design so that authors can create a CAM for a virtual world (VRCAM) in the same way as for a 
regular CAM. More details on that will be given the following sections of this report. 

4.4 VRCRT and GAL code 

In Deliverable 3.4a (Kleinermann and De Troyer, 2009a), it was decided that the adaptation rule would be 
specified from a high-level point of view, i.e. away from GAL code and that the rule would be translated into 
GAL code later on. Due to the fact that the specification of a regular CRT in the current version of the GAT is 



D3.4b - Initial Implementation of an authoring platform for adaptive VR learning material   (v1.0), 
2010-01-25 

Initial Implementation of a VR authoring tool Page 26 (76) 

done by having GAL code being explicitly entered, we also have adapted our design. Although we do have a 
prototype that helps the author to specify a VRCRT from a higher-level and away from GAL code, we have 
decided not to introduce it in this version of the VR authoring tool as GAL is still being refined at the time of 
writing this deliverable. 
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5 Description of the implementation of the VR Autho ring tool and its 
integration with the GAT 

This chapter will describe the implementation of the VR Authoring Tool in terms of its integration with GAT 
(Albert et al., 2009) (Hendrix et al., 2009). It will explain how the integration has been done also in terms of 
exchange of data and the data models being supported in the current version of the VR Authoring tool. 

 

5.1 Integration of the VR Authoring tool with the othe r components of the GAT tool 

The VR Authoring tool is realized as module that can be launched from the main GAT shell (Albert et al., 
2009) (Hendrix et al., 2009) (Hendrix and Harrigan, 2009) which is integrated into a web browser like Internet 
Explorer1 or Firefox2. The main part of the VR authoring tool is written in Flex 3.0 (Noble and Anderson, 
2008) and ActionScript (Lott et al., 2006).  

The tool supports a previewer which is realized using a freely available VR player (Vivaty player3) and it 
makes the connection with it through the Scene Authoring Interface (SAI) (Brutzman and Daly, 2008) and 
JavaScript (Flanagan, 1998). Note that this can also be done with other X3D players supporting SAI. The 
previewer allows an author to visualize an adaptation specified through the use of a Virtual Reality 
Adaptation State (explained in the next sections). Figure 14 shows by means of a high-level overview how 
the VR Authoring Tool is called from the GAT and communicates data.  

Although the VR Authoring tool can be directly called from the GAT shell, it can also operate as an 
independent module as it does not depend on the GAT shell for obtaining and storing information. This is 
done using the same web services as those used by GAT. 

Figure 15 shows the different data models used in the VR Authoring Tool. All the files following those formats 
are then stored through web services. The structure of these models will be explained in the next subsection.  

 

 

Figure 14. GAT and VR Authoring tool 

 
 
1 http://en.wikipedia.org/wiki/Internet_Explorer 
2 http://en.wikipedia.org/wiki/Mozilla_Firefox 
3http://www.vivaty.com/downloads/player/ 
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Figure 15. Architecture of VR Authoring Tool with the different data models 

 

In GAT, the VR Authoring tool is invoked by selecting the menu item VR Toolbox. Figure 16 shows how the 
VR Authoring tool appears once the author selected this option. 

 

Figure 16. VR Authoring Tool invoked from GAT 

 

 

The VR Authoring Tool itself is explained in chapter 6. 
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5.2 Integration of Data from the VR Authoring tool int o CAM 

As explained in deliverable 3.4a (Kleinermann and De Troyer, 2009), the VR resource (or also called VR 
Learning Material) can either be included into a CAM as a black box (i.e. with no adaptation inside of it) or 
with adaptation inside of it using VRCAM. In both cases, we have to integrate the VR Learning Resources 
into the CAM. For this, we use the notion of Entity introduced in the CAM format (Hendrix et al., 2009) and 
also how normal CRTs are integrated in the CAM.  

This means that Entity in our case is used to refer to (1) a VR resource with no adaptations that can have 
been specified at the domain level or at the CAM level or (2) a VR resource with adaptation inside of it 
expressed with the VR authoring tool using VRCAM. In the second case, the adaptation expressed in the 
VRCAM (see next section) is integrated directly into sockets and entities of the CAM model (Hendrix and 
Harrigan, 2009). In our approach, adaptation inside VR learning material happens by having VR objects with 
unique ID (see also section 6.3) being in certain VRAS. To express this in the CAM, we are also using Entity 
where a VRAS can actually be seen as VR resource, only it is used for adaptation inside a VR Learning 
Material. Such VR resource is described in XML and is composed as follow: 

 
a. idvw : represents the uuid of the VR resource in which the adaptation applies to. 
b. titlevw: provides the name of the virtual World 
c. idconcept : this corresponds to the id of the concept 
d. nameconcept : this gives the name of a concept 
e. idobj : corresponds to the id of the VRObjects that can be retrieved by the VR plug-in 
f. locationvr: provides the location of the file containing the Virtual World 
g. idas: the id of a Virtual Reality Adaptation State (VRAS) 
h. tagid: the id of a node that can be retrieved by the VR plug-in to turn on/off a VRAS 
i. parameter: the X3D instruction to be used to turn on/off a VR Adaptation State 
j. value: the value to be used 
k. type: the type of value i.e. integer, string, float, boolean 

 
 

In deliverable 4.2b (Kleinermann et al., 2010), it is explained how GALE can interact with the VR plug-in and 
communicates that VR resource to the VR plug-in which will then interpret it. Note that the VRCRTs like the 
CRTs are expressed in XML format and can therefore be integrated like normal CRTs in the CAM data 
model.  

 

5.3 VRCAM 

The VRCAM is like a CAM but it is dedicated to VR for creating adaptation inside of it. They can be 
integrated into a CAM when CAM mixes VR Resources with adaptation and normal resources used in the 
CAM. However, VRCAM can be used as a standalone. It follows the same format of CAM but in more 
restricted way. It has also the notion of socket where socket can have concepts id and location of VR 
Resources.  

At the time of writing this report and since it is the first initial implementation of the VR Authoring as well as of 
GALE, an initial XML specification has been provided in appendix 10.1 for the VRCAM. However, it is likely 
that it will change in the next few months when the initial implementation of GALE and the VR authoring 
component will be refined. The final XML specification for the VRCAM will be given in the final deliverable i.e. 
the deliverable 3.4c.  

 

5.4 Repository for VR 

A Repository is used to store all the VR resources and can then be accessed by the VR plug-in to retrieve a 
VR resource. The VR resource can be VR resources in terms of content or VR resources that are used for 
GALE to communicate to the VR plug-in to tell to inform the VR player what to change in the scene being 
displayed. 
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5.5 Specification of the VR data models 

In order to integrate the different components of GAT, it was decided that the all the models will follow a 
certain format. The following section explains this. 

5.5.1 Common header 
The following XML code outlines the common structure of GRAPPLE authoring tool models. As outlined in 
deliverable 3.3b (Hendrix and Harrigan, 2009), each model has a common header part, where Meta-data of 
the model is located. Meta-data include title, common description, creation and update time, author, 
authorisation, and the UUID of the model. Below is a short outline of the common parts of the XML format. 

<model> 
  <header> //the header is shared between all models  
    <modeluuid>660e8400-e29b-41d4-a716-446655440000 </modeluuid> 

//the modelUuid is a unique identifier for the mode l. 
    <modeltype>DM</modeltype> 

//Types can be DM, CRT, CAM or their VR and Simulat ion 
equivalent 

    <authoruuid>660e8400-e29b- a716-41d4-4466554400 00</authoruuid> 
     // the author UUID is the unique identifier of  the author, who 

created the model 
    <authorisation>readwrite</authorisation> 
     // authorisation for all other author; the ori ginal author always 

has all permissions. 
    <creationtime>2002-10-10T17:00:00Z</creationtim e> //the timestamp of 

creation of the model  
    <updatetime>2002-11-10T17:00:00Z</updatetime> //the timestamp the model was 

last updated  
    <title>sun-example-dm</title> //the title of the model  
    <description>sun-example-dm</description> //the description of the model  
  </header> 
  <body> //the body contains the actual content of the model . For VR it can 

VRAdaptation States, VRCRT and VRCAM  
     
  </body> 
</model> 
 

The different VR models also follow that structure. However each of the VR models itself will be included 
between the tags <body> and </body>. 

5.5.2 Data Model for the VRCAM 
Virtual Reality Conceptual Adaptation Model (VRCAM) represents the adaption model to be used to create 
adaptation inside a virtual world. Each time a VRCAM is created, it is stored in VRCAM data model which 
follow the general data model format. 

As it was requested to have a visual editor for a VRCAM, we have adopted the graph approach used for the 
CAM where the main components of the graph are nodes and links. In a VRCAM, the nodes are concepts 
from a VR object instance, and the links are the VRCRT relationships. The tool uses the same library as the 
one used for the CAM so that the author does not have to learn a new visual language. It also stores the 
VRCAM into a format similar to the one used for the CAM. We refer the reader to appendix 10.1 for the XML 
specification. 

5.5.3 Data Model for the VRCRT  
Like CRTs are used to specify adaptation based on relationships between concepts, VRCRTs are used to 
specify when an adaptation inside VR should happen. Like a CRT, they use the concepts of socket, user 
model variables, as well as GAL code. They are stored in an XML format. The xml specification is given in 
appendix 10.2.  

5.5.4 Data Model for VRAS  
The tool stores Virtual Reality Adaptation State (VRAS). They are used to store the adaptation state a VR 
Object can be in. They store also information on how to turn that state on and off and how it can be 
customized. More details will be given in the next chapter. VRAS are stored in XML format and follow the 
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general data model format (see section 5.5.1). They have a header and a body. Their XML specification is 
given in the appendix 10.3. 

5.5.5 Data Model for VRRAW 
To create adaptation in VR resource, the author has to import the VR resource (which is X3D in our case 
(Brutzman and Daly, 2008)) so that it can be processed to retrieve VR Objects that compose a scene and 
which can be adapted. They are also stored into the general data model format explained in 5.5.1. Actually, 
they are stored VR resources (expressed in X3D format) that can be later used by the author to indicate 
which VR objects composing the scene will be subjected to adaptation. This is also why we called this data 
model Virtual Reality Raw data model since it is not yet processed. An XML specification is given in the 
appendix 10.4. 

5.5.6 Data Model for VRLM 
To identify the VR Objects that can be subjected to adaptation, the author will upload VRRaw resources and 
then he will define which VR Object can be subject to adaptation. Indeed, in large virtual worlds, there can be 
a lot of VR objects. Adaptation may be performed only to some of them. These will be stored into a data 
model called here Virtual Reality Learning Material (VRLM). The XML specification is given in the appendix 
10.5. 

5.5.7 Data Model for VRLO 
In our approach, the author can then upload a VR resource expressed as VRLM data model (possible VR 
Objects for adaptation has been identified) to define VRAS to these VR Objects. The result of this is then 
stored in a data model called Virtual Reality Learning Object (VRLO). The XML specification is given in the 
appendix 10.6. Chapter 6 and chapter 7 will explain how an author creates such VRLOs. Note that that VR 
resource of type VRLO data model will be used by the author to create a VRCAM. 
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6 Description of the VR Authoring Tool 

The VR Authoring tool component is invoked by the user from the general GAT shell by selecting the VR 
menu. Then, a VR Toolbox manager appears as a popup window (see figure 17). The VR Authoring tool 
component itself has three menus which are the File menu, the Tool Menu and the Help Menu (see figure 
17).  

 

 

Figure 17. VR Toolbox manager for the VR Authoring tool 

 

·  The File menu has five menu items namely New, Open, Import X3D, Insert VRCAM and Exit.  
o The New menu item results in a menu that allows the author to create Virtual Reality 

Adaptation States (VRAS), to create Virtual Reality Concept Relation Type (VRCRT), to 
create Virtual Reality learning Material (VRLM), to create Virtual Reality Learning Objects 
(VRLO) and Virtual Reality Conceptual Adaptation Model (VRCAM).  

o The Open menu item results in a menu that can open the above model types i.e. VRAS, 
VRCRT, VRLM, VRLO and VRCAM.  

o The import X3D menu item allows the author to import new Virtual Reality Material in X3D 
format (Brutzman and Daly, 2008). They are stored as VRRaw Data Model.  

o The Insert VRCAM menu item allows author to include VR resources into a CAM. VR 
resource can be one with adaptation inside of it or one with no adaptation inside of it. 

·  The Tool menu associated with the Tool item has only one item called Preview VR Resources which 
is a previewer of VR resources. 

·  The help item provides some helps to the author. 
 

All of these menu items will be explained in the next subsections. If the author selects  File->Exit or the black 
cross (upper right corner), he returns to the main GAT shell.  

We will now review each components of the VR Authoring tool. 

Before starting to explain in more details the different elements of the VR Authoring tool component, it is 
important to realize that when the author creates a new file by going to   File->New, a window (see figure 18) 
firstly displayed in which he can enter the name and a description. The author will also select a type of data 
model. According to the type that he has selected, an appropriate window will be displayed once he presses 
the button Create.  

Also in the VR Authoring tool component when the author goes in File->Open, a window (see figure 19) is 
displayed in which the author can select a file. Once he has selected a file an appropriate window according 
to the type of file he has selected will then be displayed. 
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Figure 18. New File 

 

 

Figure 19. File to Open 
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6.1 Previewing VR resource 

The VR authoring tool component of the GAT allows the author to preview VR resources. This can be used 
by an author to see what the VR resource looks like. He can also decide to copy and paste the link for 
adding a VR resource to a concept by using the domain component of the GAT tool or by inserting a VR 
resource in a socket of the CAM using the CAM component of the GAT. To launch the previewer, the author 
goes in the VR authoring component of the GAT to Tool->Preview VR Resources. Figure 20 shows the 
previewer. 

 

Figure 20. Previewing VR resources 

6.2 Importing Existing VR Resource 

To define adaptation in VR resource, the VR resource must be processed. The first step in our approach is 
to provide the possibility to the author to import new VR resource that are created by available VR content 
authoring tools (Murdock, 2010), (Chopra, 2009) and for which the user wants to create adaptation inside of 
it. This is done by the VR authoring tool component. VR Material can be imported if it is specified using X3D 
format (Brutzman and Daly, 2008). To import VR resource, the author can go in the VR Authoring tool 
component to File->New and selects VRRAW as type (see figure 21). The tool will then send an event by 
calling the appropriate UI (see figure 22).  

 

 



D3.4b - Initial Implementation of an authoring platform for adaptive VR learning material   (v1.0), 
2010-01-25 

Initial Implementation of a VR authoring tool Page 35 (76) 

 

Figure 21. New file for importing VR material. It is a VRRAW format 

 
The author has to open a regular editor and copy/paste the X3d code into the window presented in order to 
import it (see figure 22). This is possible as the X3D format is an XML format. We recognized that this is not 
the best and most usable way of importing VR resource but it is due to a limitation of Flex (Noble and 
Anderson, 2008) which does not allow you to look to the local file system. A better solution is currently being 
explored and will be integrated in the final version of the VR Authoring tool component, to be reported in 
deliverable 3.4c.  

Note that each time an author goes to File->New in the VR authoring tool component, the author will have a 
first window like the one shown in figure 21 where he needs to select the right type of Data Model, include 
some description and name it, before it results in a new window corresponding to the right type data model. 
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Figure 22. Copy and Paste X3D Code 

 

 

6.3 Preparing the VR Resource Materials 

In order to be able to adapt VR objects in a virtual world, we need to be able to identify these objects, e.g. by 
means of an identifier (ID). VR resource in X3D format can be created with different VR content authoring 
tools (Murdock, 2010), (Chopra, 2009) or being found on the Internet. However, they may not always have 
IDs for the virtual objects they include. If IDs are available, they may also not have meaningful names, at 
least not from the viewpoint of the course author. However, these IDs are important for an author as he 
needs to use them to map virtual objects to domain concepts of his course so that he can use them when he 
designs his VRCAM. These IDs will also be used by the VR plug-in to know which VR objects should be 
adapted. Therefore, the VR Authoring tool allows an author to identify VR objects by entering his own IDs. 
The tool will also make sure that the author does not enter the same ID for two different VR objects. Note 
that not all the VR objects of a virtual world need to be identified, only those that will be used for the 
adaptation. 

It was decided to do the identifying through a GUI. As an X3D structure is a scene graph based structure 
(tree structure) (Brutzman and Daly, 2008), we provide a visualization of the scene graph as a tree so that 
the author can select the node that he wants to give an ID.   
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The component of the tool provides two versions of the tree. The first one is the original scene graph 
represented as a tree (see left side of figure 23) and the second one is also the scene graph but where the 
IDs of nodes has been changed/added (see right side of figure 23). The middle part of the GUI (see figure 
23) contains two text boxes. 

The one on the top displays the node ID selected by the author when he clicks on a particular node of the left 
tree. The bottom text box is an input box and allows the author entering the ID that he wants to assign to the 
node. In Figure 23, the author has selected the node "EarthCoordinateSystem" and changed that name to 
"Earth". Note that each node, for which the IDs have changed, will have a prefix "Author_" in front of it. This 
helps the author to see which one he has changed and will be subject to adaptation. 

Furthermore, this VR Authoring tool component can be used in two modes, represented by two tabs in the 
GUI (see figure 23). The first tab Identify VR objects allows the author to identify VR objects through the GUI 
as described. The second tab Console allows an author to see the actual XML file.  

Once the author is happy with the IDs that he did provide, he can then store the results by pressing the 
button Save the X3D. This will invoke the web services to store the file. It will have the extension “.vrlm” as it 
is stored as VRLM data model.  To call this component from the VR authoring tool component, the author 
selects Tool->Identify VR Learning Material. 

 

 

Figure 23. Identifying VR objects 

 

 

6.4 Virtual Reality Adaptation States 

In chapter 3, it was described what features of a VR object and a virtual world can be adapted. The VR 
authoring tool allows an author to specify these specifications through so-called Virtual Reality Adaptation 
States (VRAS). A VRAS allows an author to define the effect of an adaptation. For instance, the VRAS 
named Marking will “draw” a box around an object (actual the box becomes visible).  
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6.4.1 Defining a VRAS 
For the implementation, it is important to let the VR plug-in know how to trigger a VRAS. This is done by 
means of a TAG name and a trigger used to invoke or revoke the VRAS. Two values will be specified for that 
trigger, i.e. one for turning on the VRAS and one for turning it off. Let’s illustrate this with an example. 

Suppose an author wants to introduce a new VRAS that makes a box around a VR object visible. For this, 
the author selects in the VR Authoring tool component File->New and then selects type VRAS. He then 
enters the VR Code for the VRAS, here X3D Code for a box with some material properties. He then provides 
a TAG that represents the node in the scene graph and which refers to the VRAS. This TAG will be used by 
the VR plug-in to retrieve the node. In this example, the author enters the TAG EnableVRStateMark (see 
figure 24).  

He also specifies the trigger, as well as its values, for turning on/off the VRAS. Note that this trigger should 
be used in the X3D code as an X3D instruction. In the example, the author uses as trigger an X3D 
instruction called scale to turn the VRAS on and off. Here the value 1 1 1 is used for this parameter to turn 
the state on and the value 0.050.050.05 to turn it off. He also has to give the type of these values; here the 
type is float. 

 

 

Figure 24. Adaptation State "Marking" with the VR Code and the instruction to turn it on/off 

6.4.2 Allowing to customize a VRAS 
Sometimes, it can be useful to reuse a VRAS for different VR objects. We illustrate this with the VRAS 
EnableVRStateMark. Since that VRAS adds a box around the object, it would be nice that the author can 
also specify the size of the box and its colour. Then, the VRAS can be used for different VR objects and in 
different situations. For this, the author of that VRAS can add four additional parameters that can customize 
the VRAS when used, namely the size of the box along the X-axis, the size of the box along the Y -axis and 
along the Z-axis as well as the colour. For each parameter, he will have to specify the default value as well 
as the type of parameter. Note that these parameters refer to parameters in the X3D code of the VRAS that 
can be changed. In figure 25, we see parameter bbx, bby, bbz. These parameters can then be changed by 
the author to customize the VRAS. For instance here, they can be used to change the size of the box.  He 
can also provide a description for each parameter which will help other authors to understand how the VRAS 
can be customized. Figure 25 illustrates this. 

Once the author is happy with it, he can then save it. The VRAS will be saved under the format ".vras".  
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Note that the tab console is used by the author to enter directly in XML the VRAS. At anytime, the author can 
change or update a VRAS by selecting in the VR Authoring tool component :  File->Open and selecting the 
appropriate VRAS file.  

 

 

 

Figure 25. Adaptation State "Marking" with parameters 

 

6.5 Preparing the VR Learning Objects 

The three previous subsections explained how to import VR material, how to identify virtual objects in VR 
resources and the creation of VRAS. These are activities that should be done by someone who has some 
knowledge about X3D. The idea is to have a library of such VR resources and VRASs that is available to 
course authors so that they can use it for making adaptive E-learning courses with VR resource, but without 
the need to have knowledge about X3D.  

Before an author can specify an adaptive VR course (by creating the VRCAM), he first needs to prepare the 
VR resource. It is a step in which the author selects the VR resource for his course, then adds a number of 
possible VRAS for VR objects. It is also during that step that he can customize a VRAS so that it fits his 
course. For instance, an author may want to use the VRAS VRStateMark, but he would like to have the 
edges of the box in blue rather than red and the size of the box smaller since the VR object for which he will 
use the VRAS is smaller. The VR Authoring tool component allows this by providing a component for 
Customization. 

Figure 26 shows the interface after the author has selected a VR resource which is a virtual world with only 
one identified VR object being the planet Earth. He then selected the VRAS VRStateMark for the VR object 
with ID "Author_EarthCoordinateSystem" and customizes the colour parameter.  He can preview the 
adaptation by pressing the button Preview Adaptation State.  Once the author is satisfied, he can save the 
VR Learning Object. This will be stored as data model having the extension ".vrlo". 
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Figure 26. Customization of Adaptation State and Preparation of Learning Object 

 

Note that the tab console is used by the author to enter directly in XML the VRLO. At anytime, the author can 
change or update a VRLO by selecting in the VR Authoring tool component:  File->Open and selecting the 
appropriate VRLO file.  

 

Figure 27 summarizes the steps that are followed to create a VR resource that can then be used in VRCAM.  

 

 

Figure 27. Summary of the stages used to prepare a VR resource for which VRCAM can be created 

6.6 Virtual Reality Concept Relationship Type (VRCRT) 

The VR authoring tool component allows the author to create their own Virtual Reality Concept Relationship 
Type (VRCRT). VRCRTs follow the same principles as the regular Concept Relationship Types (CRT), but 
they are dedicated to Virtual Reality material. The tool has been designed so that the way VRCRTs are 
created is similar to the way regular CRTs are created. In this way, an author does not have to learn new 
ways of making VRCRTs. The VRCRT uses the concept of socket like CRTs (Steiner and Nussbaumer, 
2009).  
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To create a new VRCRT, the author selects from the VR Toolbox Manager, File->New  and then selects the 
type VRCRT. A window will then popup in which there will be four tabs (see figure 28). We will now describe 
each of them. 

6.6.1 General Tab 
This tab allows entering general information about the VRCRT, such as the name of the VRCRT and a 
description. Two types of VRCRTs are possible. The first type is the Directed relation. It implies a source and 
a target socket with some cardinality. Cardinality is used to indicate the number of VR objects that can be 
included. The symbol * means any number. The minimum must be one. See figure 28 for an example. The 
other type of VRCRTs is the Undirected Relation. This VRCRT can have several sockets. But there is no 
order in which they are processed.  

 

 

 

Figure 28. VRCRT 

6.6.2 Visual Properties 
As a VRCAM will be constructed by an author using a visual graph, the VRCTs need to have a visual 
representation. This is specified by means of visual properties (see figure 29). The visual representation of a 
VRCRT is done by means of nodes and links. The author can specify the colour of an edge and the shape of 
the node. VRCRTs like CRTs have also sockets that have a shape and a colour. These sockets will be 
connected via links that will have a certain colour.  

6.6.3 GAL Code 
The GAL tab allows specifying the GAL code that will be used to tell when adaptation should happen inside 
the VR. An example will be given in the user guide (see section 7.3). 

6.6.4 User Model 
The User Model tab (see figure 30) allows specifying the variables from the user model that will be used in 
this VRCRT. For instance, a user variable can be knowledge or visited. A user model variable will have a 
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value and a type. It can also have a location telling where the information can be obtained. More on this will 
be explained later in chapter 7. 

 

 
Figure 29. Visual Properties of VRCRT 

 
Figure 30. User Model tab 
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6.6.5 Console 
The console tab shows the VRCRT in XML format. The author can directly change the VRCRT by modifying 
its XML. 

When the user saves the VRCRT, it will be saved as a data model of type “.vrcrt”. Note also that the author 
can always read and change a VRCRT. For this, he needs to select from VR Authoring tool component:  
File->Open and select “name of the file” with the type “.vrcrt”. 

 

6.7 Virtual Reality Conceptual Adaptive Material (VRCA M) 

Virtual Reality Conceptual Adaptive Model (VRCAM) allows author to create adaptation inside a VR 
resource. We will now see how this is done. 

Suppose that the author creates a CAM that uses a prerequisite CRT between the concept planet and the 
concept earth. However now he also would like to create an adaptation inside the VR resource that he will 
use. For instance, he would like to have a spotlight set on the planet earth in the virtual world so that the 
learner cannot miss it. As in the previous subsection, the author will launch the VR Toolbox manager (i.e. VR 
Authoring tool component) and go to File->New and then adds a name, a description and type of data model 
VRCAM (see figure 18). This will result in a window in which he will firstly needs to select a VR resource with 
VR Object that can be used for adaptation. Note that these VR resources are with type “.vrlo’. Two lists will 
then be shown (see top of figure 31). The first list lists all the VR Objects that can be used for adaptation. 
Here he has selected a VR resource which contains two VR Objects that can be adapted namely 
Author_EarthCoordinateSystem and Author_SunCoordinateSystem. The second list lists all the associated 
VRAS to a VR Object when he selects a VR Object from the first list (see top left side of Figure 31). Here, he 
has selected EarthCoordinateSystem and it has two VRAS associated to that VR Object namely 
EnableVRStateMark, EnableVRStateSpotLight and none. none is a special VRAS as it tells that no VRAS 
should be triggered on. At anytime the author can preview the VR resource by selecting a VR Object from 
the first list and an associated VRAS from the second list. In figure 31 (see right side of figure 31), the author 
is previewing the VR Object Author_EarthCoordinateSystem with the VRAS EnableVRStateSpotLight. 

To be able to create a VRCAM, the author will also select a domain model (see left bottom side of figure 31). 
Then, the concepts of the domain will appear in a list (see list on the bottom left side of figure 31). Using that 
list, the author will map VR Objects and Concepts by selecting a VR object from the list of VR Objects (see 
left top of figure 31) and selecting a concept from the list of concepts (see list bottom left of figure 31) and 
pressing the button add Mapping. The mapping will then be shown in a double list (next to the list of 
concepts see figure 31). This is done so that later the VR plug-in knows which concepts have been accessed 
from within the VR resources being displayed by the VR player. This information will be used by GALE to 
update the User Model.  

Once the author has created the mappings, he can start to create the actual VRCAM by pressing the button 
Visualize VRCAM (see bottom of figure 32). A GUI will popup in which the author can compose his VRCAM 
by selecting VRCRTs and concepts. An example of this is shown in Figure 32. Note that the item in the 
socket represents the ID of the VR object as well as the VRAS to be used. This is specified as VR object_ID 
[VRAS TAG]. 

More details on how to create a VRCAM will be given in the next section, chapter 7 (the User Guide). 
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Figure 31. Creating adaptation inside VR Learning Material 

 

 
Figure 32. Example of VRCAM 

 
 



D3.4b - Initial Implementation of an authoring platform for adaptive VR learning material   (v1.0), 
2010-01-25 

Initial Implementation of a VR authoring tool Page 45 (76) 

  

6.8 Importing VR resources into CAM 

There are different ways for importing VR resources into a CAM. We will now review them. 

6.8.1 VR resources attached to Concepts using the domain  tool component from 
the GAT tool. 

Using the domain component from the GAT tool (see deliverable 3.1b (Dicerto and Oneto, 2009), an author 
can attach resources (in form of url) to concepts. These resources can be VR resource. They can be inserted 
into a CAM once the user uses the concepts of a domain.  Note the author can always preview these VR 
resources by invoking the VR authoring tool component and going to Tool->Preview VR Resources. 

6.8.2 Adding VR resource directly into the CAM  
The CAM tool component from the GAT tool allows an author to insert resources (having url location) to 
sockets (see deliverable 3.3b (Hendrix and Harrigan, 2009) ). The author in that case can also add VR 
resources. The author can always preview the VR resource by invoking the VR authoring tool component 
and going to Tool->Preview VR Resources.  

6.8.3 Inserting a VRCAM to a CAM 
The VRCAM describes adaptation inside a VR resource. Here special care has to be taken when inserting a 
VRCAM as it needs to be inserted completely into the CAM.  

For this the user needs to go to File->Insert VRCAM. This will result in a window (see figure 33) which will 
ask the user to choose the socket of the CAM in which the VRCAM needs to be inserted and also to choose 
the VRCAM to insert. 

6.8.4 X3D previewer 
To help the author to see how the VR resource looks like, the author can preview them by going to the VR 
Authoring tool component of the GAT tool (i.e. calling the VR Authoring tool) and going toTool->Preview VR 
Resources. There, a window will be displayed having the VR player embedded inside the window and having 
a text box in which a url location can be provided by the author. By entering the url location of a VR resource 
and pressing the button “Preview”, the author can preview the VR resource (see figure 34).  

This helps authors to visualize their VR Resources. 

 



D3.4b - Initial Implementation of an authoring platform for adaptive VR learning material   (v1.0), 
2010-01-25 

Initial Implementation of a VR authoring tool Page 46 (76) 

 

Figure 33. Inserting a VRCAM into a CAM 
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Figure 34. Previewer of VR Resources 
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7 User Guide  

In chapter 6, the VR authoring tool component of the GAT has been described. Chapter 6 explained also the 
different extension that was made so that existing available VR materials can be imported and be used.  This 
chapter will now provide an example of how the tool can be used for creating an adaptive course with some 
adaptive VR resources. We start with giving the scenario. The course is about the solar system. 

Suppose that the author firstly wants to give a general introduction on the solar system. (This will be 
specified by a regular CAM). But he also wants to illustrate a planet by showing as an example the planet 
earth in 3D. However, here no adaptation of the VR material itself is needed. The adaptation in the course 
will happen until that point only via the normal hypertext way. At some point in the course, the author wants 
to show also the star sun in 3D. But this time, he wants to show a virtual world with the planet earth along the 
sun in order to provide the learner a notion of distance between earth and sun. However, he wants to ensure 
that the learner has enough knowledge on the planet earth before displaying the sun completely. For this he 
can use a virtual world in which the sun will be initially semi-hidden until the learner has enough knowledge 
on earth. To guide the student about what he still needs to study, the author decides that he will set a red 
spotlight on earth until the knowledge of the learner about earth is above a certain threshold. Once the 
learner has enough knowledge about earth, he will show earth without spotlight and sun without the semi-
hidden box around it.  

We now explain how this scenario can be realized using the VR Authoring tool component. But we will start 
first to explain how VR resources can be prepared so that adaptation can be defined inside of it. 

 

7.1 Step 1: Prepare the course by importing the right VR resource 

The first step that the author has to do is to prepare a VR resource. Here, we will assume that no VR 
resource yet exists in the library. We will also assume that the author has knowledge about X3D or that he 
can ask the help of someone with knowledge about X3D.  

For the scenario above, the author needs to have a VR resource being a virtual world having a VR object 
representing earth and a VR object representing the sun. To create this virtual world, VR content authoring 
tool like (Murdock, 2010), (Chopra, 2009)  can be used. But he can also find what he needs on the Internet. 
The only requirement is that the VR resource must be in X3D format. Let’s suppose that he has such 
material.  

 

To import VR resource, the author launches the VR Authoring tool component and selects File -> Import 
X3D. This will result in a window (like figure 18) asking to the author to enter a name, a description. Then, a 
new window will be displayed in which he can copy and paste the X3D code (see figure 35). He saves that 
X3D content. This generates a file with the type VRRaw data model.  Next, the author needs to identify VR 
Objects that can be used for adaptation.  

For this, he then goes to File->New. This result in a window (like figure 18) asking him to enter the name of a 
file; to give a description and choosing the type of data model, here VRLM. By pressing the button Create, a 
new window (like the one in figure 19) will be shown asking him to select a file. He will select a file that he 
has created when importing the X3D code. Note that it is a file of type “.vrraw”. Then a new window will be 
displayed (see figure 36) in which the author can identify the VR objects needed, here earth and sun. Figure 
36 shows that the VR object representing planet earth has been identified by the author since the ID is now 
Author_EarthCoordinateSystem (see the tree on the right side of Figure 36). He will do the same for the Sun. 
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Figure 35. Import of a virtual world with planet earth and star sun 
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Figure 36. Identifying VR objects 

7.2 Step 2: Add VRASs 

Next, the author wants to specify some adaptation possibilities for his VR resource. For that, he will use the 
Virtual Reality Adaptation States (VRAS) to define the visual effect of an adaptation. In our scenario, the 
author wants to be able to place a red spotlight on the VR object earth and to display a semi-transparent box 
around the VR object sun. Therefore a VRAS, called VRStateSpotlight, that sets a red spotlight and a VRAS, 
called VRSateSemiHidden, that display a semi-transparent box around will be used. 

To do this, the author selects from the VR Authoring tool component, File->New. This will result in a window 
(like figure 18) asking to the author to enter a name, a description and to select the type of data model (here 
VRAS). Then, a new window will be displayed (see figure 37). The author will select a VR resource of type 
VRLM (i.e. a VR resource in which VR objects than can be used for adaptation, have been identified (see 
previous subsection)) by pressing the button Upload VR World. The author will then select the VR resource 
having the virtual world with the identified VR objects representing Earth and Sun. Then, the VR objects will 
be shown in a comboBox list (see top left side of figure 37) and the available VRAS from the library will be 
shown into another comboBox list (see left side of figure 37). The author will select the VR object 
Author_EarthCoordinateSystem and he will also select the VRAS that he wants to apply to it, here the VRAS 
VRStateSpotLight. By selecting that VRAS, he can then see a list of parameters that he can customize (see 
list left middle part of figure 37). For instance, the author will select the red colour for the light. He can always 
preview his selection (see figure 37). Once he is satisfied with his customization, he can store it. He does the 
same for the other VR object. Once he is happy with the VRAS associated with the VR Objects, he can then 
store them. This will be stored as a VR resource having the type of data model “VRLO”. 
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Figure 37. Add VR Adaptation State VRStateSpotlight 

 

7.3 Step3: Define VRCRTs 

For the scenario given, the author will need VRCRTs that specify the adaption to show the VR object earth 
with a red spotlight on it and the VR object sun as semi-hidden until the learner has acquired enough 
knowledge, then sun will be shown without semi-hidden box and earth will not have anymore a red spotlight 
on it. For this, three VRCRTs will be used, VRCRTDisplayAfter to specify that some VR objects should be 
displayed after some condition has been met; VRCRTStart responsible for initializing the knowledge to a 
certain value and to set VR Objects in a certain VRAS; and VRCRTKnowledgePropagation which is 
responsible for propagating knowledge when the user has acquired more knowledge by accessing VR 
resources. Note the VRCRTDisplayAfter corresponds to the adaptation defined in chapter 3 called 
DisplayAfter. 

To illustrate how such VRCRT is created we explain the process for VRCRTDisplayAfter. First, the author 
selects in the VR Authoring tool component File->New. This will result in a window (like figure 18) in which 
the author can enter the name of the VRCRT, a description and type vrcrt. By pressing the button Create, a 
new window will then be displayed (see figure 38). 

 

In the General Tab (see figure 38), the author selects a directed relation having two sockets Source and 
Target. Both sockets have a cardinality of 1 to many.  In the Visual Properties tab, the user selects the 
default visual properties (see figure 39). 
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Figure 38. VRCRTDisplayAfter: General Tab 

 

 
Figure 39. VRCRTDisplayAfter: Visual Properties tab 
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In the GAL tab (see figure 40), the author can then enter the GAL code that specifies the adaptation rule. 
Here, the VR objects in the target socket will be shown as soon as all the objects in the source socket are 
above the threshold of 50. 

 

 

 

Figure 40. VRCRTDisplayAfter: GAL code 

 

 
The author also needs to specify the user variable(s) that are used in the source and target socket, here, 
knowledge. He states this in the User Model tab (see figure 41). Note that the location specifies where the 
user model variables should be found (if it is used from an LMS outside of the GRAPPLE). 

This concludes the specification of VRCRTDisplayAfter. VRCRTStart and VRCRTKnowledgePropagation are 
created in a similar way.  

.  
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Figure 41. VRCRTDisplayAfter: User Model tab 

 

7.4 Step 4: Create a VRCAM to specify the adaptation i nside the VR Learning 
Material showing earth and sun  

 

The author is now ready to create a VRCAM. For this, he will go in the VR Authoring tool component   to  
File->New. This will result in a window (like figure 18) in which the user can then enters the name of the file, 
a description and select the type VRCAM. Once he presses the button Create, a new window will be 
displayed (see figure 42).  

 

The author will firstly need to select a VR resource with VR Object that can be used for adaptation. Here he 
will select the VR resource having the earth and the sun that have been identified. Once he has selected that 
VR resource, the first list lists all the VR Objects that can be used for adaptation. Here he has selected a VR 
resource which contains two VR Objects that can be adapted namely Author_EarthCoordinateSystem and 
Author_SunCoordinateSystem. The second list lists all the associated VRAS to a VR Object when he selects 
a VR Object from the first list (see left of Figure 42). Here, he has selected Author_SunCoordinateSystem 
and it has only two VRAS associated which are EnableVRStateSemiHide and none. Note that none is a 
special VRAS as it tells that non VRAS should be triggered on on. At anytime the author can preview the VR 
resource by selecting a VR Object from the first list and an associated VRAS from the second list. In figure 
42 (see right of figure 42), the author is previewing the VR Object Author_SunCoordinateSystem  with the 
VRAS EnableVRStateSemiHide. 

To be able to create a VRCAM, the author will also select a domain model (see left bottom of figure 42). 
Here, he will select the domain model related to the solar system. The concepts of the domain will appear in 
a list (see list on the bottom left side of figure 42). Using that list, the author will map VR Objects and 
Concepts by selecting a VR object from the list of VR Objects (see left top of figure 42) and selecting a 
concept from the list of concepts (see list bottom left of figure 42) and pressing the button add Mapping. The 
mapping will then be shown in a double list (next to the list of concepts see figure 42). Here he has mapped 
to the VR object Author_EarthCoordinateSystem to the concept Earth and the VR object 
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Author_SunCoordinateSystem to the concept Sun.  The author can then create his VRCAM by pressing the 
button Visualize VRCAM. 

 

  

 
Figure 42. Adaptation inside VR 

 

 

To compose his VRCAM, he will first use the VRCRT called VRCRTStart to initialize the knowledge for earth 
and sun and to display the concept Earth using the VRAS EnableVRStateSpotlight and the concept Sun 
using the VRAS EnableVRStateSemiHide. This will ensure that in the virtual world a red spotlight is set on 
earth and the sun will be semi-hidden (see figure 43). 

He will then use the VRCRT VRCRTDisplayAfter to remove the spotlight and to show the sun fully as soon 
as the necessary knowledge has been obtained. In the Source socket, he adds the concept earth with the 
VRAS EnableVRStateSpotlight  and the concept sun with the VRAS EnableVRStateSemiHide. In the Target 
socket, he adds the concept earth and Sun without VRAS (see figure 44). Note that the name of a VR object 
is followed by the VRAS to be used between brackets. 

 

The last VRCRT that is added (see figure 45) is needed to ensure that GALE updates the knowledge 
variables correctly when resources are accessed. This is done by using the VRCRT 
VRCRTKnowledgePropagation. Figure 45 shows the complete VRCAM.  
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Figure 43. VRCRT: Adding VRStart 

 

 

 

 
Figure 44. VRCRT: Adding VRDisplayAfter 
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Figure 45. Complete VRCAM  

7.5 Step 5: adding the VRCAM to the CAM  

 

We suppose here that the author has already created a CAM using GAT. Figure 46 shows this CAM in GAT. 
Figure 47 is a zoom on that CAM.  

 

 

Figure 46. Overall view of the CAM in GAT 
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Figure 47. CAM in more details 

 

The CAM shows that the course should start by introducing the Solar System. It shows that the concept 
Planet must be studied before the concept Earth. The same goes for the concept Star and the concept Sun. 
Now, the author wants to include his VRCAM in his course.  

According to the scenario, the VRCAM should be added when the Sun concept is studied and therefore it 
should be included into the CAM socket called advanced[Star] for Sun. 

To add the VRCAM to the CAM, the author goes in the VR Authoring tool component and selects             
File->Insert VRCAM. This results in the window shown in figure 48. In that window, the author selects the 
socket from the CAM model in which he wants that VRCAM to appear, here the CAM socket called 
advanced[Star] for Sun. He also needs to import the VRCAM.  He then presses the button Save. The 
VRCAM is then stored into the CAM data model. 
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Figure 48. VRCAM being inserted into a socket of the CAM related to the Solar system 

 
7.6 Step 6: adding a VR resource with no adaptation in side to the CAM  

In the scenario, the author also wants to insert a VR resource having no adaptation in order to show earth in 
3D once the author visits the concept planet. For that he will insert that VR resource to the socket having 
beginner[planet] using the CAM component of the GAT. But before doing this, he will make sure that the link 
corresponds to the correct VR Resource. To check this, he will invoke the Previewer (see figure 49) from the 
VR authoring tool component by selecting Tool->Preview VR Resources to visualize that resource and then 
copy and paste that link into the appropriate CAM socket using the CAM component of the GAT tool. 
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Figure 49. Checking the VR Learning Material 
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8 General Discussion 

The VR Authoring tool component requires at this moment to install an X3D player as plug-in for the internet 
browser. Here, we use the vivaty player1. In the recent months, there has been some progress with the X3D 
community to have the next generation of internet browser like Firefox2 to integrate HTML 5 and X3D. This 
will then avoids users to have to download plug-ins. The architecture presented in this document will still be 
valid.  

During last year, we have extended our approach to allow an author to import existing VR material. To 
achieve this, we have seen that a number of steps were necessary. This may sound not to be so accessible 
to authors. However, we believe that someone who has followed those steps few times, will be able to do 
that. Furthermore, once the VR material has been transformed, it can then be used for different courses. 
Therefore, this process of transformation needs to be done once.  

In this deliverable, we have also seen that new adaptation state can be added. However, we recognize that it 
may not be easy for authors to do this and this may be left to someone who has some VR background. But 
again, once a new adaptation state has been added, it can be used for all the different courses being 
created.  

It was also explained in chapter 6 and chapter 7 how an author can create new VRCRTs for creating 
adaptation that can be used in a VRCAM. We recognize that one problem with the way VRCRTs are 
created, is that authors must know about GAL and scripting. Furthermore, GAL is really not author friendly. 
This situation is far from being ideal and we are currently working on a way to allow authors not having to 
learn and know about GAL for creating VRCRTs. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 
1http://www.vivaty.com/downloads/player/ 
2 http://en.wikipedia.org/wiki/Mozilla_Firefox 
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9 Conclusion and Outlook 

Deliverable 3.4a (Kleinermann and De Troyer, 2009) provides related work and also an initial design of the 
VR authoring component.  In this deliverable, we have  

 

·  revised the material from the previous deliverable (D3.4a); 

·  provided a more in depth of the design and implementation of the authoring tool; 

·  explained how it is integrated with the rest of the Grapple Authoring Tool (GAT); 

·  avoided using new visual language for creating a course having VR materials; 

·  provided ways for an author to add new VR materials and new adaptation for VR; 

·  provided a short user-guide. 

 

This first implementation will be subject to further improvements in the next few months. The results will be 
presented in deliverable 3.4c.  
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10 Appendix 

The appendix shows provides the XML specification for each Data Model. Note that these DATA models are 
still under development until the final deliverable 3.4c. 

 

10.1 XML Schema for Virtual Reality Conceptual Adaptati on Model (VRCAM) 

<?xml version="1.0" encoding="UTF-8"?> 
<schema xmlns="http://www.w3.org/2001/XMLSchema" targetNamespace="http://www.example.org/CAM-
external-oct2009" xmlns:tns="http://www.example.org/CAM-external-oct2009" 
elementFormDefault="qualified" xmlns:Q1="http://www.imsglobal.org/xsd/imsvdex_v1p0" 
xmlns:Q2="http://grapple-project.org/GAT/" xmlns:Q3="http://www.grapple-project.org"> 
 
    <import schemaLocation="dm-vdex-extensions.xsd" namespace="http://www.grapple-
project.org"></import> 
    <import schemaLocation="VRCRT.xsd" namespace="http://grapple-project.org/GAT/"></import> 
    <import schemaLocation="vdex.xsd" 
namespace="http://www.imsglobal.org/xsd/imsvdex_v1p0"></import> 
    <element name="model" type="tns:modelType"></element> 
     
    <complexType name="modelType"> 
     <sequence maxOccurs="1" minOccurs="1"> 
      <element name="header" type="tns:headerType" maxOccurs="1" 
minOccurs="1"></element> 
      <element name="body" type="tns:vrCAMBodyType" maxOccurs="1" 
minOccurs="1"></element> 
     </sequence> 
    </complexType> 
 
    <complexType name="headerType"> 
     <sequence> 
      <element name="modeluuid" type="tns:UUIDtype" maxOccurs="1" 
       minOccurs="1"> 
      </element> 
      <element name="modeltype" type="string" maxOccurs="1" 
       minOccurs="1"> 
      </element> 
      <element name="authoruuid" type="tns:UUIDtype" maxOccurs="1" 
minOccurs="1"></element> 
      <element name="authorisation" type="tns:authorisationType" maxOccurs="1" 
minOccurs="1"></element> 
      <element name="creationtime" type="dateTime" maxOccurs="1" 
minOccurs="1"></element> 
      <element name="updatetime" type="dateTime" maxOccurs="1" 
minOccurs="1"></element> 
      <element name="title" type="string" maxOccurs="1" minOccurs="1"></element> 
      <element name="description" type="string" maxOccurs="1" minOccurs="1"></element> 
     </sequence> 
    </complexType> 
     
    <complexType name="vrCAMBodyType"> 
     <sequence> 
      <element name="vrCAM" type="tns:vrCAMType" maxOccurs="1" 
minOccurs="1"></element> 
     </sequence> 
    </complexType> 
     
 
    <simpleType name="authorisationType"> 
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     <restriction base="string"> 
      <enumeration value="read"></enumeration> 
      <enumeration value="write"></enumeration> 
      <enumeration value="readwrite"></enumeration> 
     </restriction> 
    </simpleType> 
 
    <simpleType name="UUIDtype"> 
     <restriction base="string"> 
      <pattern 
       value="[a-z0-9]{8}\-[a-z0-9]{4}\-[a-z0-9]{4}\-[a-z0-9]{4}\-[a-z0-9]{12}"> 
      </pattern> 
     </restriction> 
    </simpleType> 
 
 
    <complexType name="vrCAMType"> 
     <sequence> 
      <element name="vrCAMInternal" type="tns:vrCAMInternalType"></element> 
     </sequence> 
    </complexType> 
 
    <complexType name="vrCAMInternalType"> 
     <sequence> 
      <element name="domainModel" type="tns:dmModelType" maxOccurs="1" 
       minOccurs="1"> 
      </element> 
      <element name="vrcrtModel" type="tns:vrcrtModelType" maxOccurs="1" 
       minOccurs="1"> 
      </element> 
      <element name="vrcrt" type="string" maxOccurs="unbounded" 
minOccurs="0"></element> 
     </sequence> 
    </complexType> 
 
 
    <complexType name="positionType"> 
     <sequence> 
      <element name="x" type="int"></element> 
      <element name="y" type="int"></element> 
     </sequence> 
    </complexType> 
 
    <complexType name="vrCAMSocketType"> 
     <sequence> 
      <element name="caption" type="string" maxOccurs="1" 
       minOccurs="0"> 
      </element> 
      <element name="uuid" type="tns:UUIDtype" maxOccurs="1" 
       minOccurs="1"> 
      </element> 
      <element name="socketId" type="tns:UUIDtype" maxOccurs="1" 
       minOccurs="1"> 
      </element> 
      <element name="position" type="tns:positionType" 
       maxOccurs="1" minOccurs="1"> 
      </element> 
      <element name="shape" type="string" maxOccurs="1" minOccurs="0"></element> 
      <element name="colour" type="string" maxOccurs="1" minOccurs="0"></element> 
      <element name="entity " type="tns:entityType" maxOccurs="unbounded" 
minOccurs="0"></element> 
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     </sequence> 
    </complexType> 
 
    <complexType name="entityType"> 
     <sequence> 
      <element name="dmID" type="tns:UUIDtype" maxOccurs="1" 
       minOccurs="0"> 
      </element> 
      <element name="label" type="string" maxOccurs="unbounded" 
       minOccurs="0"> 
      </element> 
      <element name="relationshipType " type="string" maxOccurs="1" 
minOccurs="0"></element> 
      <element name="position" type="tns:positionType" maxOccurs="1" 
minOccurs="0"></element> 
      <element name="size" type="int" maxOccurs="1" minOccurs="0"></element> 
      <element name="shape" type="string" maxOccurs="1" minOccurs="0"></element> 
      <element name="image" type="string" maxOccurs="1" minOccurs="0"></element> 
      <element name="colour" type="string" maxOccurs="1" minOccurs="0"></element> 
     </sequence> 
    </complexType> 
 
    <complexType name="dmModelType"> 
     <sequence> 
      <element name="model" type="tns:dmModelType2" maxOccurs="unbounded" 
minOccurs="0"></element> 
     </sequence> 
    </complexType> 
 
    <complexType name="dmModelType2"> 
     <sequence> 
      <element name="header" type="tns:headerType"></element> 
      <element name="body" type="tns:dmType"></element> 
     </sequence> 
    </complexType> 
 
    <complexType name="dmType"> 
     <sequence> 
      <element name="vdex" type="Q1:vdexType" maxOccurs="1" minOccurs="1"></element> 
     </sequence> 
    </complexType> 
 
    <complexType name="vrcrtModelType"> 
     <sequence> 
      <element name="model" type="tns:crtModelType2" maxOccurs="unbounded" 
minOccurs="0"></element> 
     </sequence> 
    </complexType> 
 
    <complexType name="vrcrtModelType2"> 
     <sequence> 
      <element name="header" type="tns:headerType" maxOccurs="1" 
       minOccurs="1"> 
      </element> 
      <element name="body" type="tns:crtType" maxOccurs="1" 
minOccurs="1"><complexType></complexType></element> 
     </sequence> 
    </complexType> 
 
    <complexType name="vrcrtType"> 
     <sequence> 
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      <element name="vrcrtdialect" type="Q2:vrcrtdialecttype" 
       maxOccurs="1" minOccurs="1"> 
      </element> 
      <element name="comment" type="Q3:contentType" maxOccurs="1" 
       minOccurs="1"> 
      </element> 
      <element name="visualrepresentation" type="string"></element> 
      <element name="vrcrtsockets" type="string"></element> 
      <element name="adaptationbehaviour" type="string"></element> 
      <element name="constraints" type="string"></element> 
      <element name="associateddmrelations" type="string"></element> 
     </sequence> 
    </complexType> 
</schema> 

 

10.2 XML Schema for Virtual Reality Concept Relation Ty pe (VRCRT) 

<?xml version="1.0"?> 
<xs:schema  
  xmlns:xs="http://www.w3.org/2001/XMLSchema" 
  targetNamespace="http://grapple-project.org/GAT/" 
  xmlns="http://grapple-project.org/GAT/" 
  elementFormDefault="qualified"> 
 
  <!-- (A) The overall structure and the model header --> 
 
  <xs:element name="model"> 
    <xs:complexType> 
      <xs:sequence> 
        <xs:element name="header"> 
          <xs:complexType> 
            <xs:sequence> 
              <xs:element name="modeltype" type="modeltypetype" minOccurs="1" maxOccurs="1"/> 
              <xs:element name="modeluuid" type="xs:string" minOccurs="1" maxOccurs="1"/> 
              <xs:element name="authoruuid" type="xs:string" minOccurs="1" maxOccurs="1"/> 
              <xs:element name="authorisation" type="xs:string" minOccurs="1" maxOccurs="1"/> 
              <xs:element name="title" type="xs:string" minOccurs="1" maxOccurs="1"/> 
              <xs:element name="description" type="xs:string" minOccurs="1" maxOccurs="1"/> 
              <xs:element name="creationtime" type="xs:dateTime" minOccurs="1" maxOccurs="1"/> 
              <xs:element name="updatetime" type=" xs:dateTime " minOccurs="1" maxOccurs="1"/> 
            </xs:sequence> 
          </xs:complexType> 
        </xs:element> 
        <xs:element name="body"> 
          <xs:complexType> 
            <xs:sequence> 
              <xs:element name="vrcrt" minOccurs="1" maxOccurs="1"> 
                <xs:complexType> 
                  <xs:sequence> 
                    <xs:element ref="vrcrtdialect" minOccurs="1" maxOccurs="1"/> 
                    <xs:element ref="comment" minOccurs="1" maxOccurs="1"/> 
                    <xs:element ref="visualrepresentation" minOccurs="1" maxOccurs="1"/> 
                    <xs:element ref="vrcrtsockets" minOccurs="1" maxOccurs="1"/> 
                    <xs:element ref="adaptationbehaviour" minOccurs="1" maxOccurs="1"/> 
                  </xs:sequence>               
                </xs:complexType> 
              </xs:element> 
           </xs:sequence> 
          </xs:complexType> 
        </xs:element> 
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      </xs:sequence> 
    </xs:complexType> 
  </xs:element> 
 
  <xs:simpleType name="modeltypetype"> 
    <xs:restriction base="xs:string"> 
      <xs:enumeration value="vrcrt"/> 
    </xs:restriction> 
  </xs:simpleType> 
 
  <!-- (B) The seven elements of the CRT definition --> 
 
  <!--  (B.1) the CRT dialect  --> 
  <xs:element name="vrcrtdialect" type="vrcrtdialecttype"/> 
 
  <xs:simpleType name="vrcrtdialecttype"> 
    <xs:restriction base="xs:string"> 
      <xs:enumeration value="vrcrt"/> 
    </xs:restriction> 
  </xs:simpleType> 
 
  <!-- (B.2) the comment field --> 
  <xs:element name="comment" type="xs:string"/> 
 
  <xs:element name="visualrepresentation"> 
    <xs:complexType> 
      <xs:sequence> 
        <xs:element name="shape" type="xs:string" minOccurs="1" maxOccurs="1"/> 
        <xs:element name="colour" type="xs:string" minOccurs="1" maxOccurs="1"/> 
      </xs:sequence>               
    </xs:complexType>             
  </xs:element> 
 
  <xs:element name="vrcrtsockets" >  
    <xs:complexType> 
      <xs:sequence> 
        <xs:element name="socket" minOccurs="1" maxOccurs="unbounded"> 
          <xs:complexType> 
            <xs:sequence> 
               <xs:element name="name" type="xs:string" minOccurs="1" maxOccurs="1"/>                            
               <xs:element name="uuid" type="xs:string" minOccurs="1" maxOccurs="1"/>                            
               <xs:element name="mincardinality" type="xs:string" minOccurs="1" maxOccurs="1"/>                            
               <xs:element name="maxcardinality" type="xs:string" minOccurs="1" maxOccurs="1"/>                            
               <xs:element name="colour" type="xs:string" minOccurs="0" maxOccurs="1"/>                            
            </xs:sequence> 
            <xs:attribute name="type" type="xs:string" use="required"/> 
          </xs:complexType> 
        </xs:element> 
      </xs:sequence> 
    </xs:complexType> 
  </xs:element> 
   
 <xs:element name="adaptationbehaviour">  
    <xs:complexType> 
      <xs:sequence> 
        <xs:element name="usermodel" minOccurs="1" maxOccurs="1"> 
          <xs:complexType> 
            <xs:sequence> 
              <xs:element ref="umvariable" minOccurs="0" maxOccurs="unbounded"/> 
            </xs:sequence> 
          </xs:complexType> 



D3.4b - Initial Implementation of an authoring platform for adaptive VR learning material   (v1.0), 
2010-01-25 

Initial Implementation of a VR authoring tool Page 70 (76) 

        </xs:element> 
        <xs:element name="galcode" type="xs:string" minOccurs="1" maxOccurs="1"/> 
      </xs:sequence> 
    </xs:complexType> 
  </xs:element> 
 
  <xs:element name="umvariable"> 
    <xs:complexType> 
      <xs:sequence> 
         <xs:element name="umvarname" type="xs:string" minOccurs="1" maxOccurs="1"/>                            
         <xs:element name="public" type="xs:boolean" minOccurs="1" maxOccurs="1"/>                            
         <xs:element name="persistent" type="xs:boolean" minOccurs="1" maxOccurs="1"/>                            
         <xs:element name="type" type="xs:string" minOccurs="1" maxOccurs="1"/>                            
         <xs:element name="range" type="xs:anyType" minOccurs="0" maxOccurs="1"/>                            
         <xs:element name="default" type="xs:string" minOccurs="1" maxOccurs="1"/>                            
         <xs:element name="location" minOccurs="0" maxOccurs="1"> 
          <xs:complexType> 
            <xs:sequence> 
              <xs:element name="web" minOccurs="0" maxOccurs="1"/> 
              <xs:element name="remotecourse" type="xs:anyType" minOccurs="0" maxOccurs="1"/> 
            </xs:sequence> 
          </xs:complexType> 
         </xs:element> 
      </xs:sequence> 
    </xs:complexType> 
  </xs:element> 
</xs:schema> 

10.3 XML Schema for Virtual Reality AdaptationState (VR AS) 

<?xml version="1.0" encoding="UTF-8"?> 
<schema xmlns="http://www.w3.org/2001/XMLSchema" targetNamespace="http://www.example.org/CAM-
external-oct2009" xmlns:tns="http://www.example.org/CAM-external-oct2009" 
elementFormDefault="qualified"> 
 
    <element name="model" type="tns:modelType"></element> 
     
    <complexType name="modelType"> 
     <sequence maxOccurs="1" minOccurs="1"> 
      <element name="header" type="tns:headerType" maxOccurs="1" 
minOccurs="1"></element> 
      <element name="body" type="tns:vrasBodyType" maxOccurs="1" 
minOccurs="1"></element> 
     </sequence> 
    </complexType> 
 
    <complexType name="headerType"> 
     <sequence> 
      <element name="modeluuid" type="tns:UUIDtype" maxOccurs="1" 
       minOccurs="1"> 
      </element> 
      <element name="modeltype" type="string" maxOccurs="1" 
       minOccurs="1"> 
      </element> 
      <element name="authoruuid" type="tns:UUIDtype" maxOccurs="1" 
minOccurs="1"></element> 
      <element name="authorisation" type="tns:authorisationType" maxOccurs="1" 
minOccurs="1"></element> 
      <element name="creationtime" type="dateTime" maxOccurs="1" 
minOccurs="1"></element> 
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      <element name="updatetime" type="dateTime" maxOccurs="1" 
minOccurs="1"></element> 
      <element name="title" type="string" maxOccurs="1" minOccurs="1"></element> 
      <element name="description" type="string" maxOccurs="1" minOccurs="1"></element> 
     </sequence> 
    </complexType> 
     
    <complexType name="vrasBodyType"> 
     <sequence> 
       
      <element name="adaptationstate" type="tns:adaptationstateType" maxOccurs="1" 
minOccurs="1"></element> 
       </sequence> 
    </complexType> 
     
 
    <simpleType name="authorisationType"> 
     <restriction base="string"> 
      <enumeration value="read"></enumeration> 
      <enumeration value="write"></enumeration> 
      <enumeration value="readwrite"></enumeration> 
     </restriction> 
    </simpleType> 
 
    <simpleType name="UUIDtype"> 
     <restriction base="string"> 
      <pattern 
       value="[a-z0-9]{8}\-[a-z0-9]{4}\-[a-z0-9]{4}\-[a-z0-9]{4}\-[a-z0-9]{12}"> 
      </pattern> 
     </restriction> 
    </simpleType> 
     
    <complexType name="adaptationstateType"> 
     <sequence> 
      <element name="name" type="string" maxOccurs="1" minOccurs="1"></element> 
      <element name="description" type="string" maxOccurs="1" minOccurs="1"></element> 
      <element name="parameters" type="tns:parametersType" maxOccurs="unbounded" 
minOccurs="1"></element> 
      <element name="vrcode" type="tns:vrcodeType" maxOccurs="1" 
minOccurs="1"></element> 
     </sequence> 
    </complexType> 
    <complexType name="parametersType"> 
     <sequence> 
      <element name="parameter" type="tns:parameterType" maxOccurs="1" 
minOccurs="1"></element> 
        </sequence> 
    </complexType> 
     
    <complexType name="parameterType"> 
     <sequence> 
      <element name="type" type="string" maxOccurs="1" minOccurs="1"></element> 
      <element name="defaultvalue" type="string" maxOccurs="1" minOccurs="1"></element> 
      <element name="description" type="string" maxOccurs="1" minOccurs="1"></element> 
        </sequence> 
    </complexType> 
     
    <complexType name="vrcodeType"> 
     <sequence> 
      <element name="code" type="string" maxOccurs="1" minOccurs="1"></element> 
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      <element name="triggeron" type="tns:triggeronType" maxOccurs="1" 
minOccurs="1"></element> 
      <element name="triggeroff" type="tns:triggeroffType" maxOccurs="1" 
minOccurs="1"></element> 
        </sequence> 
    </complexType> 
     
    <complexType name="triggeronType"> 
     <sequence> 
      <element name="vrtag" type="string" maxOccurs="1" minOccurs="1"></element> 
      <element name="vrtriggerinstruction" type="string" maxOccurs="1" 
minOccurs="1"></element> 
      <element name="vrtriggervalue" type="string" maxOccurs="1" 
minOccurs="1"></element> 
      <element name="vrtriggertype" type="string" maxOccurs="1" minOccurs="1"></element> 
        </sequence> 
    </complexType> 
     
     <complexType name="triggeroffType"> 
     <sequence> 
      <element name="vrtag" type="string" maxOccurs="1" minOccurs="1"></element> 
      <element name="vrtriggerinstruction" type="string" maxOccurs="1" 
minOccurs="1"></element> 
      <element name="vrtriggervalue" type="string" maxOccurs="1" 
minOccurs="1"></element> 
      <element name="vrtriggertype" type="string" maxOccurs="1" minOccurs="1"></element> 
        </sequence> 
    </complexType> 
       
</schema> 
   

10.4 XML Schema for Virtual Reality RAW Model (VRRAW mo del)  

<?xml version="1.0" encoding="UTF-8"?> 
<schema xmlns="http://www.w3.org/2001/XMLSchema" targetNamespace="http://www.example.org/CAM-
external-oct2009" xmlns:tns="http://www.example.org/CAM-external-oct2009" 
elementFormDefault="qualified" > 
 
    <element name="model" type="tns:modelType"></element> 
     
    <complexType name="modelType"> 
     <sequence maxOccurs="1" minOccurs="1"> 
      <element name="header" type="tns:headerType" maxOccurs="1" 
minOccurs="1"></element> 
      <element name="body" type="tns:vrrawBodyType" maxOccurs="1" 
minOccurs="1"></element> 
     </sequence> 
    </complexType> 
 
    <complexType name="headerType"> 
     <sequence> 
      <element name="modeluuid" type="tns:UUIDtype" maxOccurs="1" 
       minOccurs="1"> 
      </element> 
      <element name="modeltype" type="string" maxOccurs="1" 
       minOccurs="1"> 
      </element> 
      <element name="authoruuid" type="tns:UUIDtype" maxOccurs="1" 
minOccurs="1"></element> 
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      <element name="authorisation" type="tns:authorisationType" maxOccurs="1" 
minOccurs="1"></element> 
      <element name="creationtime" type="dateTime" maxOccurs="1" 
minOccurs="1"></element> 
      <element name="updatetime" type="dateTime" maxOccurs="1" 
minOccurs="1"></element> 
      <element name="title" type="string" maxOccurs="1" minOccurs="1"></element> 
      <element name="description" type="string" maxOccurs="1" minOccurs="1"></element> 
     </sequence> 
    </complexType> 
     
    <complexType name="vrrawBodyType"> 
     <sequence> 
      <element name="x3d" type="string" maxOccurs="1" minOccurs="1"></element> 
     </sequence> 
    </complexType> 
     
 
    <simpleType name="authorisationType"> 
     <restriction base="string"> 
      <enumeration value="read"></enumeration> 
      <enumeration value="write"></enumeration> 
      <enumeration value="readwrite"></enumeration> 
     </restriction> 
    </simpleType> 
 
    <simpleType name="UUIDtype"> 
     <restriction base="string"> 
      <pattern 
       value="[a-z0-9]{8}\-[a-z0-9]{4}\-[a-z0-9]{4}\-[a-z0-9]{4}\-[a-z0-9]{12}"> 
      </pattern> 
     </restriction> 
    </simpleType> 
   
</schema> 
 
 

10.5 XML Schema for Virtual Reality Learning Material ( VRLM) 

<?xml version="1.0" encoding="UTF-8"?> 
<schema xmlns="http://www.w3.org/2001/XMLSchema" targetNamespace="http://www.example.org/CAM-
external-oct2009" xmlns:tns="http://www.example.org/CAM-external-oct2009" 
elementFormDefault="qualified" > 
 
    <element name="model" type="tns:modelType"></element> 
     
    <complexType name="modelType"> 
     <sequence maxOccurs="1" minOccurs="1"> 
      <element name="header" type="tns:headerType" maxOccurs="1" 
minOccurs="1"></element> 
      <element name="body" type="tns:vrlmBodyType" maxOccurs="1" 
minOccurs="1"></element> 
     </sequence> 
    </complexType> 
 
    <complexType name="headerType"> 
     <sequence> 
      <element name="modeluuid" type="tns:UUIDtype" maxOccurs="1" 
       minOccurs="1"> 
      </element> 
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      <element name="modeltype" type="string" maxOccurs="1" 
       minOccurs="1"> 
      </element> 
      <element name="authoruuid" type="tns:UUIDtype" maxOccurs="1" 
minOccurs="1"></element> 
      <element name="authorisation" type="tns:authorisationType" maxOccurs="1" 
minOccurs="1"></element> 
      <element name="creationtime" type="dateTime" maxOccurs="1" 
minOccurs="1"></element> 
      <element name="updatetime" type="dateTime" maxOccurs="1" 
minOccurs="1"></element> 
      <element name="title" type="string" maxOccurs="1" minOccurs="1"></element> 
      <element name="description" type="string" maxOccurs="1" minOccurs="1"></element> 
     </sequence> 
    </complexType> 
     
    <complexType name="vrlmBodyType"> 
     <sequence> 
      <element name="x3d" type="string" maxOccurs="1" minOccurs="1"></element> 
     </sequence> 
    </complexType> 
     
 
    <simpleType name="authorisationType"> 
     <restriction base="string"> 
      <enumeration value="read"></enumeration> 
      <enumeration value="write"></enumeration> 
      <enumeration value="readwrite"></enumeration> 
     </restriction> 
    </simpleType> 
 
    <simpleType name="UUIDtype"> 
     <restriction base="string"> 
      <pattern 
       value="[a-z0-9]{8}\-[a-z0-9]{4}\-[a-z0-9]{4}\-[a-z0-9]{4}\-[a-z0-9]{12}"> 
      </pattern> 
     </restriction> 
    </simpleType> 
   
</schema> 
 

10.6 XML Schema for Virtual Reality Learning Object (VR LO) 

<?xml version="1.0" encoding="UTF-8"?> 
<schema xmlns="http://www.w3.org/2001/XMLSchema" targetNamespace="http://www.example.org/CAM-
external-oct2009" xmlns:tns="http://www.example.org/CAM-external-oct2009" 
elementFormDefault="qualified" > 
 
    <element name="model" type="tns:modelType"></element> 
     
    <complexType name="modelType"> 
     <sequence maxOccurs="1" minOccurs="1"> 
      <element name="header" type="tns:headerType" maxOccurs="1" 
minOccurs="1"></element> 
      <element name="body" type="tns:vrloBodyType" maxOccurs="1" 
minOccurs="1"></element> 
     </sequence> 
    </complexType> 
 
    <complexType name="headerType"> 
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     <sequence> 
      <element name="modeluuid" type="tns:UUIDtype" maxOccurs="1" 
       minOccurs="1"> 
      </element> 
      <element name="modeltype" type="string" maxOccurs="1" 
       minOccurs="1"> 
      </element> 
      <element name="authoruuid" type="tns:UUIDtype" maxOccurs="1" 
minOccurs="1"></element> 
      <element name="authorisation" type="tns:authorisationType" maxOccurs="1" 
minOccurs="1"></element> 
      <element name="creationtime" type="dateTime" maxOccurs="1" 
minOccurs="1"></element> 
      <element name="updatetime" type="dateTime" maxOccurs="1" 
minOccurs="1"></element> 
      <element name="title" type="string" maxOccurs="1" minOccurs="1"></element> 
      <element name="description" type="string" maxOccurs="1" minOccurs="1"></element> 
     </sequence> 
    </complexType> 
     
    <complexType name="vrloBodyType"> 
     <sequence> 
       
      <element name="location" type="string" maxOccurs="1" minOccurs="1"></element> 
      <element name="vw" type="tns:vwType" maxOccurs="1" minOccurs="1"></element> 
     </sequence> 
    </complexType> 
     
 
    <simpleType name="authorisationType"> 
     <restriction base="string"> 
      <enumeration value="read"></enumeration> 
      <enumeration value="write"></enumeration> 
      <enumeration value="readwrite"></enumeration> 
     </restriction> 
    </simpleType> 
 
    <simpleType name="UUIDtype"> 
     <restriction base="string"> 
      <pattern 
       value="[a-z0-9]{8}\-[a-z0-9]{4}\-[a-z0-9]{4}\-[a-z0-9]{4}\-[a-z0-9]{12}"> 
      </pattern> 
     </restriction> 
    </simpleType> 
     
    <complexType name="vwType"> 
     <sequence> 
      <element name="x3d" type="string" maxOccurs="1" minOccurs="1"></element> 
     </sequence> 
    </complexType> 
   
</schema> 
 

 

10.7 XML Schema for VRResource for GALE and the VR plug -in 

<?xml version="1.0" encoding="UTF-8"?> 
<schema xmlns="http://www.w3.org/2001/XMLSchema" targetNamespace="http://www.example.org/CAM-
external-oct2009" xmlns:tns="http://www.example.org/CAM-external-oct2009" 
elementFormDefault="qualified"> 
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    <element name="VRResource" type="tns:VRResourceType"></element> 
     
    <complexType name="VRResourceType"> 
     <sequence maxOccurs="1" minOccurs="1"> 
      <element name="idvw" type="tns:UUIDtype" maxOccurs="1" minOccurs="1"></element> 
      <element name="titlevw" type="string" maxOccurs="1" minOccurs="1"></element> 
      <element name="idconcept" type="tns:UUIDtype" maxOccurs="1" 
minOccurs="1"></element> 
      <element name="nameconcept"  type="string" maxOccurs="1" 
minOccurs="1"></element> 
      <element name="idobj" type=" string" maxOccurs="1" minOccurs="1"></element> 
      <element name="locationvr" type="string" maxOccurs="1" minOccurs="1"></element> 
      <element name="type" type="tns:vrresourceType" maxOccurs="unbounded" 
minOccurs="1"></element> 
     </sequence> 
    </complexType> 
 
    <complexType name="vrresourceType"> 
     <sequence> 
      <element name="vras" type="tns:vrastype" maxOccurs="1" minOccurs="1"></element> 
     </sequence> 
    </complexType> 
     
    <complexType name="vrastype"> 
     <sequence> 
       <element name="idas" type=" string"" maxOccurs="1" minOccurs="1"></element> 
      <element name="tagid" type=" string" maxOccurs="1" minOccurs="1"></element> 
      <element name="parameter" type="string" maxOccurs="1" minOccurs="1"></element> 
      <element name="value" type="string" maxOccurs="1" minOccurs="1"></element> 
      <element name="type" type="string" maxOccurs="1" minOccurs="1"></element> 
       </sequence> 
    </complexType> 
     
    <simpleType name="UUIDtype"> 
     <restriction base="string"> 
      <pattern 
       value="[a-z0-9]{8}\-[a-z0-9]{4}\-[a-z0-9]{4}\-[a-z0-9]{4}\-[a-z0-9]{12}"> 
      </pattern> 
     </restriction> 
    </simpleType> 
             

</schema> 
 

 

 


